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Starting a new crossword

You can start a new crossword by selecting New from the File menu or clicking on the icon on the toolbar. The

New Crossword window will also appear when you start the program.

Click on the button corresponding to the type of puzzle you want to make. You can also click on one of

templates and press the Other template button to create other types of puzzles.

The options are:

Cryptic or quick Standard non-American puzzle.

American Standard American puzzle

Freeform/vocabulary Non-symmetric puzzle using themed words. You can generate these
automatically from a short list of words.

Word search Puzzle where the solver has to circle words in the grid. You can
generate these automatically from a short list of words.

Shape Puzzle with a non-rectangular outline. You can fill the shape with
words from a short list.

Barred Words are separated by thick lines rather than black squares.

Clues in squares Short clues are written directly into squares in the grid.

Coded Each square has a number corresponding to the letter, crack the
letter code to solve the puzzle.

Sudoku 
(Number Place)

Number puzzle in which each number appears once in each row,
column and 3x3 (or larger) subsquare.

Other templates supplied are

French Style Squares are numbered down the side and clues numbered by column and
row.

Italian These are like a standard crossword except that the black squares do not fill
the square.

If you want to re-open an existing puzzle click the Recent files button and select one, or click on the Open
existing file button. If you don’t want the New Crossword window to show when you start the program

uncheck the Show at startup box.
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Using Different Languages

Crossword Compiler has the capability to make puzzles in many languages, and supports the full Unicode

character set.

Changing language settings

Change the words to use instead of “Across”, “Down”, etc., under Clue Properties. You can also change other

settings on the Language Specifics page of Clue Properties. Save the file as a template to re-use your settings

the next time you make a crossword.

Exporting Interactive web puzzles

Translate the captions of the buttons in the solving applet under Applet Properties. You can also change the

completion message.

Using foreign characters

There is an option under the Buttons page of Applet Properties to “Always show alphabet”. This displays a

list of letters below the grid so that solvers can click on them to enter characters into the grid. This allows

people with any computer setup to solve multi-language puzzles easily simply by clicking with the mouse

to enter characters that are not present on their keyboard layout. The characters shown in the alphabet

are set under Clue Properties, Language Specifics.

Exporting Web Pages

Web page export supports most languages. You can also translate or make your own HTML templates in any

language if you wish. See the HTML templates topic for details.

Using different character sets in word lists

Crossword Compiler word lists support different character sets, either full unicode or separate restricted sets.

See the Character Sets topic for more information. How accents are handled is determined by the Equivalent

Letters setting. There is a similar Indexing setting for Clue Databases in the Database Manager.
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Ordering Crossword Compiler

The program can be ordered online and downloaded immediately. Please see:

https://www.crossword-compiler.com/ordering.html

After purchasing you can also visit the above page to buy additional optional extras including many additional

word lists, the Professional Grid Filler, and WordWeb Pro.

https://www.crossword-compiler.com/ordering.html
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Opening an existing file

Open an existing crossword file by selecting Open... from the File menu. Enter the name of the file to open, or

select the folder and file from the list boxes and press Open.

To open a file with a different set of settings you can open a puzzle using the settings from one of the available

crossword template.

You can open files in various crossword formats, including all versions of Crossword Compiler.

Files that you have edited recently can be reopened by clicking on their file names at the bottom of the File
menu.

Plain text import is also supported. In the File, Open window select the Plain Text option in the drop-down list

of files types. The format of the text file is fairly flexible. The program can open files in the plain text format

exported by Crossword Compiler, the plain text Across format, and various other plain text formats. It expects

grid data first, followed by clues. The clue numbers are ignored, clue linking is not supported, English language

is assumed and no error-checking is performed. So you should check the opened puzzle carefully to make

sure everything is as you expect!

If you wish to open a puzzle just to print it out for solving purposes you can hold down the Shift key when you

open a puzzle. This shows the crossword in puzzle view so that you cannot accidentally see any of the

solution words.

You can also hold down the Ctrl key when opening a puzzle in order to test-solve the puzzle on screen. This

replaces the letters in the grid with question marks, so you can view the clues without seeing the solution.
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Crossword Templates

Whenever you start a new crossword you are given the choice of various templates to choose from. These are

just Crossword Compiler files with settings information which you can re-use to make new crosswords. Having

different templates saves the bother of changing the settings each time you do a crossword, and you can have

different templates with wildly different settings for the different types of puzzle you create.

There are four templates corresponding to the buttons in the New Puzzle window. These are called American,

Default, Standard, and Shape. The Default template is used for freeform/vocabulary puzzles and Standard for

cryptic or quick puzzles. The default template is also used whenever you open a crossword in a non-

Crossword Compiler format. The standard templates aren’t listed in the New Crossword window, but you can

still change them if you like.

Creating a new template

All you have to do is start a new crossword with one of the existing templates, change any settings that you

want changed, and select Save as template... from under Templates on the File menu. Enter a name for the

new template and press OK. Your new template will now be added to the list of available templates for use

when you create a new crossword.

Changing an existing template

You may wish to do this to customize some of the default templates, or just to change the settings in an

existing template. Just open a new puzzle using the existing template, make the changes, and select Save as
template... from the File menu. You can now select the template's name from the drop-down list, or just type

in the name of the template. You will be prompted to make sure you want to replace the template, and then the

change will be made.

Opening a puzzle with settings from a different template

Each crossword file has its own settings information. However, you can open a puzzle with a different set of

settings by selecting one of the existing templates when you open a crossword file. This could be very useful if

someone sends you a Crossword Compiler file and you don't share their taste for puzzles with lime green

squares and bright red lines.

Applying settings from a template to an open puzzle

Select Apply settings from template on the Templates section of the File menu to use the settings from a

template file with the puzzle you are currently working on. The settings will replace whatever settings you are

currently using for the current file.

Deleting a template

Select a template in the New Crossword window and press Delete. You cannot delete any of the four template

corresponding to the buttons in the New Puzzle window.
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Barred crosswords

Select the Barred template in the New Puzzle window
to make one of these. After you have chosen a size for
the grid select a grid pattern in the grid library or click
Design grid myself to make a new grid pattern.

Bars instead of blocks separate words. If you design

the grid yourself insert bars by pressing Alt+Cursor

keys, or double-clicking on a line with the mouse.

Barred puzzles usually have a thick border, set under

Grid Properties..

See also:

Using a grid library pattern

Editing the grid

Automatic grid filling

Finding words to fit

Writing Clues

Grid Properties

Clue Properties
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Clues in squares puzzles

Select the Clues in squares template in the New
Puzzle window to make one of these. Clues are not
written separately, but short clues are written into 'clue
squares', which have arrows pointing to the clued word.

Double-click to insert a clue square, and press the edit

button to bring up the clue square editor.

See also:

Editing the grid

The clue square editor

Grid Properties
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Coded crosswords

Select the Coded template in the New Puzzle window to make
one of these. Each letter in the grid is assigned a different
number. The idea is to fill in the grid just from the pattern of
numbers. There are no clues.

Make a hint letter visible in the puzzle by selecting a square and

changing the item under square properties.

Code grids show the code solution and are generated automatically by Crossword Compiler and look like this:

See also:

Using a grid library grid pattern

Editing the grid

Automatic grid filling

Grid Properties

Square properties.
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Freeform/vocabulary puzzles

Click on the Freeform/vocabulary button in the
New Puzzle window to make one of these. Once
you have chosen a size for the grid you can use
the Create vocabulary puzzle feature to
automatically generate the puzzle from a list of
words.

Freeform puzzles can be in either of the forms

shown on the left. Change the option in the

Create vocabulary puzzle window to make an

outline puzzle rather than filling around words

with black squares.

See also:

Creating a vocabulary puzzle

Writing Clues

Grid Properties

Clue Properties
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Shape puzzles

Click on the Shape button in the New
Puzzle window to make one of these.

You can either select one of the shapes

in the supplied grid library, like the one

on the left, or click Design new shape to

make your own.

Use the Create vocabulary puzzle or

Create word search feature to fill in the

shape automatically with words from a

short list. Alternatively you can edit the

grid yourself.

To design a shape yourself remove the grid lines from squares by pressing Ctrl+Delete or using Remove

Blanks. You can select blocks of squares to remove by holding the left mouse button down, moving the mouse

to select the squares you want to remove, and then pressing Ctrl+Delete.

Shape puzzles usually have a thick border, but you can change this under Grid Properties. You may like to

change the colors of the grid lines or individual squares. To do this change the settings under Grid Properties

or Square properties. If the puzzle shape you are making is symmetric you can change the grid symmetry

setting appropriately.

See also:

Editing the grid

Creating a vocabulary puzzle

Creating a word search puzzle

Writing Clues

Grid Properties

Square properties.

Clue Properties
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Standard crosswords

Across

1 Aged (3)

3 Some (3)

4 Vase (3)

5 Utilize (3)

Down

1 Burden (4)

2 Greek harp (4)

Click on the Cryptic or quick or American
button in the New Puzzle window to make one
of these.

After you have chosen a size for the grid select

a grid pattern to use. Alternatively click on

Design grid myself to make a new grid

pattern.

If you design the grid yourself you can insert

blocks (black squares) by double-clicking or

pressing the spacebar. Once you've put the

blocks where you want them you can fill the

grid using AutoFill, fill the grid semi-

automatically using AutoFind or type words in

yourself.

Cryptic or quick puzzles usually have the

word length in brackets after the clue,

American puzzles do not. Change the setting

under Clue Properties.

See also:

Using a grid library grid pattern

Editing the grid

Placing theme words

Automatic grid filling

Finding words to fit

Writing Clues

Grid Properties

Clue Properties

Advanced puzzle types
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French style crosswords

Across

1 Aged

2 Some

3 Vase

4 Utilize

Down

II Burden

III Greek harp

Select the French Style template in the New
Puzzle window to make one of these.

Individual squares are not numbered. Clues are

numbered by their position in the grid. If there is

more than one clue on a given row or column then

the clues are juxtaposed under the same number.

See also:

Using a grid library grid pattern

Editing the grid

Automatic grid filling

Finding words to fit

Writing Clues

Grid Properties

Clue Properties
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Sudoku (Number Place) puzzles

Select the Sudoku template in the New Puzzle

window to make one of these. The standard

size is 9x9, however you can also make larger

sizes using an extended alphabet of symbols.

The program will place the numbers

automatically for you. The starter letters

(givens) are shown in blue and will be visible in

the puzzle when you export (as shown on the

left).

You can specify a desired difficulty level and

whether you want the givens symmetrically

placed. To generate a new fill for an existing

puzzle use the AutoFill button on the toolbar.

The solving applet supports this puzzle style,

see the Export interactive crossword topic.

For an introduction to the Sudoku see Wikipedia .

Puzzles are rated as “easy” if they can be solved by repeatedly placing single number candidates in squares.

“Medium” puzzles require use of sector elimination (e.g. if a “2” can go in two squares in a row, and both

squares are in the same block, the “2” in that block must be in that row so ”2” may be eliminated as a

possibility for the other rows in that block). “Hard” puzzles require use of disjoint subsets (e.g. if “23” and “235”

are the possibilities for two squares in a row, and “2” and “3” cannot go anywhere else in the row, “2” and “3”

must occupy those two squares, and hence “5” may be eliminated). “Very easy” are easy puzzles containing

redundant givens (i.e. numbers that could be worked out from the other given numbers).

Select Check sudoku on the Grid menu (or the toolbar button) to check a Sudoku to make sure it has a unique

solution and give it a difficulty rating. If there isn’t a unique solution a few ambiguous squares are highlighted.

The “Very hard” rating means that it cannot be solved by repeated use of the methods listed above, and is

likely to be too hard for most publications.

The starter letters (givens) are automatically set to have “Letter visible in puzzle” in Square properties. and are

shown in blue for editing purposes (you can change the color in preferences). They will appear black by default

when you export. If you’d like to change the color used when exporting select the squares (use select all -

letters visible in puzzle on the Edit menu) and then use Square properties. on the Edit menu to change the text

or background color.

The default numbers or characters used for the Sudoku are specified in the same window as the size in the

New Puzzle wizard. You can edit these, e.g. if you wish to use 9 different letters rather than the default set of

numbers 1-9.

https://en.wikipedia.org/wiki/Sudoku
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If you want to include a particular sequence of letters or characters in the grid, use the New Puzzle window to

make a new puzzle, then press Cancel when you get to the Sudoku Fill box. This gives you a blank sudoku

grid. Just type in the letters where you want them in the grid, then use the Fill button on the toolbar to complete

the grid.

To make larger puzzles than the standard 9x9, click the Other size expansion box in the New Puzzle wizard.

Instead of numbers and single letters, you can also make Sudoku using any other number or text symbol for

each equivalent entry. You can select to use Letters/Numbers (standard), a custom set of short words, or use

numbered squares (e.g. for a 4x4 puzzle, using numbers 1..16 in each square, rather than 1..9A..F).

See also:

Square properties.



15

Creating Word Search Puzzles

To create a word search puzzle from a list of words select New from the File menu and click on the Word
Search button.

Select Create word search puzzle option on the Words menu to fit words into an existing grid. For example,

you may wish to design a particular shaped puzzle, or seed the grid with a few words before filling in the rest.

The tabs along the top of the Create Word Search Puzzle window give you different ways to specify the words

that you want to use:

Use Words

Type in some words to use or select a Theme List and click on Build Puzzle.

Use Word List

Select one of the main Word Lists to use and click on Build Puzzle. The word list should not be too large.

An example: say you wanted to create a 11x11 puzzle using the architecture word list. In the create vocabulary

puzzle window you would select the Use Words tab and select 'Architecture' under Use theme word list. The

theme list will load so that you can edit or add words if you like.

Click on the Build Puzzle button and the computer will automatically generate the puzzle, for example

To accept this puzzle press the Accept button. If you don't press Accept the computer will continue to search

for puzzles that contain more of the given words. Press Accept whenever you are happy with the result

produced.

If you don't like the puzzle, and the computer is not finding any more fills, you can press the Next button to

randomly start generating a different new grid. You can press the < button to view previous fills, and Accept to
decide which one you wish to use.

You can cancel the fill at any time by pressing the Cancel button. This will let you edit your word list and re-

start the fill, or cancel entirely.

If you find that not enough of your words are used then try a bigger puzzle - change the puzzle size by clicking

on the Size button. If the words fit easily and there is too much blank space you may also want to try

decreasing the puzzle size. When you press the Size button there are options to increase or decrease the size

by two squares, or change to any size you like. [This option is only available if the starting grid is blank.]
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Now for some more details on the various options:

If you select the Use Words option you can save your list of words as a theme list by clicking on Save
words. You can then use your words just like any of the other theme lists. To delete the words you've

typed in press the Clear button. You can also use words in any plain text file - click on the Load Clues
button.

If you select a Theme List to use you can edit or add words to the list. Click the Save changes button if

you want these changes to be automatically saved in the Theme List.

Click the Hidden word/phrase to specify a hidden word to use when making the puzzle. If this option is

not used squares that are not part of any word are filled with random letters from the alphabet. After

creating the puzzle select Hidden words (unused squares) on the Words menu to view or replace the

hidden word/phrase.
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Options

Click the Options tab at the top of the Create Word Search Puzzle window.

Word placement

Words can go across or down in the grid. Check the Diagonal box to also allow them to run diagonally,

and the Backwards box to allow words to be placed backwards. If you'd like all the words to intersect

each other select the Must be linked, otherwise they are placed randomly anywhere in the grid. Checking

Allow overlaps will allow a sequence of letters to be used by two words in the same direction, otherwise

they can only share an end or start letter.

The Avoid word and sub-word option will prevent use of both a word and a phrase where the word

appears in the phrase. For example, if the list containts Britain and Great Britain, with this option turned on

the filler will only ever use one, not both. Use the Avoid duplicate substrings option to avoid duplicating

more general classes of similar entries (for example 'Freeboarding' and 'Surfboard' have the five-letter

substring 'board' in common; using this option with a length of five or fewer would ensure that only one of

these two words is used).

The Avoid accidental repeats option checks that any key word only appears once in the grid. Note that if

you have many short words this can significantly reduce the number of words that will fit.

Alphabet

Some squares in the grid will probably not be part of any word. These squares are filled with random

letters from the alphabet. You can change the alphabet here if you are making a non-English puzzle. If

you wish to use a particular set of letters (word or phase), you can use the Hidden Words option on the

words menu after building the puzzle with random letters.

Number of words

Change the Maximum number of words to use to put a limit on the number of words fit in the grid.

Prevent accidental words

When placing words into the grid some additional words may accidentally be formed by adjacent letters.

Avoiding all of these is very difficult, however you may wish to avoid vulgar or offensive words. Selecting

the Check no accidental words from blacklist box will prevent use of any words in your words blacklist.

Select the Use list as blacklist box to instead check against a given main word list with scores below the

Max score to use value chosen. The default maximum of score of 10 will avoid all the vulgar and

offensive words in the default word list. Increasing the maximum score will avoid more words, but doing

this may make it harder to fit words into the grid.
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Words used
After you have made the puzzle you can view the list of words used by selecting Key Words from the Words
menu. Here you can delete individual words, and also change the text that appears as the search word. For
example if you wanted to do a word search where the hidden words are in the grid English but shown to the
solver in French, you can edit appropriately in the Key Words window.
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Accidental words
Sometimes random letter combinations can accidentally form additional words. To check these see Accidental
Words on the Words menu after making the puzzle.
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Grid Properties
Change the option on the Advanced tab of Grid Properties if you prefer to use lines to mark the words rather
than circling them. The thickness of the lines it set by the line width setting on the main page of Grid
Properties.
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Using a grid pattern

Once you have selected the type of puzzle you want to make in the New Puzzle window and you have chosen

a size for the puzzle, you can then select a grid pattern from a grid library. Which grid library you use will

depend on what type of puzzle you want to make.

To use one of the grid patterns just click on the pattern name, and you will be able to view the pattern. You can

select a different Grid library if you want to. Click the Use pre-designed grid to use the pattern you have

selected. If you selected the cryptic or quick style you will also be given the option to fill in a basic pattern of

alternating blocks.

If you use one of the patterns from the grid library you will then be asked how you want to enter words into the

grid. You can select to enter them by hand, automatically using AutoFill, or with custom settings using Fill Grid.
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Editing the grid

This topic describes how to edit the crossword grid by hand. See the New Puzzle topic for a guide to creating

puzzles automatically, see the Create Vocabulary Puzzle topic for how to make the program build a puzzle for

you from a short list of words, or see the AutoFill and AutoFind topics for how to put words into the grid.

You enter letters from the current cursor position by typing as normal. Insert black squares (blocks) by

pressing the space bar or double-clicking with the mouse. In the puzzle there are usually words going in two

directions; to change the direction of typing press tab, or click on the direction icon on the Toolbar. The cursor

changes to show the type direction:

 To type Horizontally

 To type Vertically

You can use the cursors to move round the puzzle, or click with the left mouse button to move to a certain

square.

For a full list of keyboard commands see the Keyboard topic.

You can fill in some of the pattern or black squares (blocks) by using the Fill Blocks command on the Grid
menu, or use a grid library to use a pre-designed grid pattern..

To automatically insert blocks in symmetrical positions select one of the Symmetry options on the Grid menu.

Use one of the Style Checking options on the Grid menu to highlight squares that are misplaced according to

various popular standard puzzle styles.

You can create irregular puzzles by removing unwanted squares from the puzzle. Press Ctrl+Delete with the

cursor on the square to be removed. To remove all blank squares from the puzzle, select the Remove Blanks

command from the Grid menu. This makes the puzzle only have lines around the squares with letters or

blocks in, so giving it an irregular outline.

You can Undo editing by pressing Alt + Backspace. This moves the cursor to the end of the last editing action

and then undoes the action. You can repeat undo a large number of times to undo whole chunks of the puzzle.

Undo does not remove interlocking letters, so your intersecting words are left intact.

You can move words around using the commands on the edit menu, Ctrl+C to copy a word, Ctrl+V to paste a

word and Ctrl+X to cut a word. If you want to paste in a word starting at a particular point in the grid use

Ctrl+Shift+V, otherwise it will be pasted starting at the beginning of the current word slot.

Once you have designed a grid, or part of grid, that you are sure you want to keep, you can lock it to prevent

accidental changes. Under the Lock item on the Grid menu there are options to lock the entire grid pattern

and letters, or just to lock the block pattern, the current word, or the currently selected squares. Once you have

locked something you will not be able to change it until you unlock it, by reselecting the Lock menu item or

using Unlock all at the bottom of the Lock menu.
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As you are designing the grid, the Grid Insight feature will analyse the empty square to see if it is possible to fill

them with your default word list. If a fill is not possible, the slots will be highlighted, and the stats bar will show

the problem when the cursor is on the problem slot. If a fill requires a particular letter in a given square, the

forced letter is shown in gray. It will also analyse words in the grid, and highlight duplicate words, or (if you

have the Pro Grid Filler and that option selected), duplicate substrings.
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Keyboard control and shortcuts

Keyboard controls when editing a puzzle:

Cursors Move the cursor; right/down also change typing
direction

 

Shift+Cursors Select squares

 

Ctrl+Cursors Skip to next or previous word start

 

Alt+Cursors Insert/remove a bar on a side of the square

 

Tab Toggle the direction in which you want to type

 

Enter Move to left or top of next line

 

Spacebar Insert a default Block

 

Delete Delete letter/block at cursor

 

Ctrl+Delete Remove square from puzzle

 

Shift+Delete Delete word. Doesn't affect intersecting words

 

Alt+Delete Delete letters, but not blocks, in current selection

 

Alt+Backspace Undo

 

Alt+Enter Edit a square's properties

 

Ctrl+A AutoFind

 

Shift+Alt+A Find word to fit in word slot

 

Ctrl+E Edit Clue
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Ctrl+R Review/edit clues

 

Ctrl+W Show WordWeb with the word at the cursor (if you
have WordWeb installed).

 

Ctrl+C Copy word at cursor to clipboard

 

Ctrl+X Cut word at cursor to clipboard

 

Ctrl+V Paste word at start of current word slot

 

Ctrl+Shift+V Paste word starting at the cursor position

 

Ctrl+L Select word in the current word slot

 

Ctrl+M Select square and any symmetric squares

F1 Help Contents

 

Ctrl+S Save

See Mouse for mouse combinations and the Toolbar topic



26

Mouse

Left Button Move the cursor to the square clicked on

Ctrl+Left Button Select more squares without loosing current selection

Double Left
Button

On a square
clicked on a line

Insert default block in square
Insert a bar

Alt+ Double Left Insert the alternate block type (Clue Square or Block)

Right Button

On a letter square
On a block
square
On a clue square
On a picture

AutoFind words to fit in slot clicked on
Show the square properties
Edit the clue square
Show the picture's properties

Alt+Right button On a letter square: AutoFind words to fit in the word slot in the opposite
direction.

Ctrl+Right
button

On a letter square: Find Word to fit in word slot

The default block type is set in the Advanced page of the Grid Properties dialog box. It can either be a normal

block or a clue square, in which case the alternate block type is the other one.

You can also disallow double left-clicks from making bars or blocks in the Grid Properties dialog box. This is

sometimes useful as it can be hard work aiming exactly at a narrow line!

See Keyboard for keyboard shortcuts, and the Toolbar topic.
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The main toolbar

The toolbar is the array of icons at the top of the program window. By clicking on them with the mouse you can

quickly invoke the command they represent. You can hold the mouse cursor over a button for a short time to

pop up a hint that tells you what the button does.

Here is a complete description of the top buttons:

  

 Show the New Puzzle window

  

 Open an existing file

  

 Save the crossword

  

 Invoke AutoFind

  

 Fill Automatically from cursor. The drop-down menu links
to the Fill Grid window, and (with the Pro Filler), manual
word selection or custom-saved fill configurations.

  

 Toggle the typing direction (Across/Down)

  

 Undo last change. Can be used multiple times.

  

 Edit Clue

  

 Review/edit clue list

  

 Edit Square properties

There is also a secondary toolbar below the main one. The Edit, Puzzle and Solution buttons change the grid

view. The other buttons are:

  

Moving mouse selects squares

Moving mouse marks key words
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Zoom in (view puzzle larger)

Zoom out (view puzzle smaller)

Check the grid

Grid Insight fillability status (red/green/gray icon color)
and options

See Editing the Puzzle for more information on undoing and type directions.
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Grid symmetry

You can automatically create a symmetric pattern by selecting one of the Symmetry options from the Grid
menu. You can have Normal (S) Symmetry, Dual-Symmetry (Dual-Symmetry only works if you have a square

puzzle), left/right and top/bottom symmetries.

This pattern shows Dual-Symmetry: Whereas this one only has S-Symmetry:
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Grid Properties

Select Grid Properties from the Grid menu to change various settings for how the grid is displayed and

edited. You can also edit the grid properties when you are exporting by clicking on the Grid Properties button in

the export window.

The dialog box displayed has two pages of settings, standard and advanced. When you have changed some

properties you can see the effect by clicking on the Apply button.

Colors

Change these settings to affect every square in the grid that has default color settings. Use the Square

Properties dialog box to change the colors of individual squares. You can choose a custom color by selecting

the Custom item, which will then show a window allowing you to choose any color in the spectrum. Note that

custom colors may not show on screen exactly as they should if your screen setting is less than 16 million

colors . The Line color is setting is used for the grid lines and bars. Check the Thick puzzle border box to

make the outside border of the crossword thicker (the thickness of a bar).

Square Numbering

Change this setting for how all the squares in the grid are numbered. Normal is the standard clue numbering

scheme. Sequentially numbers each square left to right then top to bottom. By Letter is useful for coded-

crosswords where each square is given a number depending on the letter in the square. None leaves the

square numberless.

If you select By Letter the program will automatically create a code at random. To force the program to create

a new code select Generate new code from the Grid menu. You can also select the Use sequential code
item on the Grid menu if you prefer the code to be generated based on the order of appearance of the letters

in the grid.

You will generally wish to make this setting tally with a corresponding clue numbering scheme in the Clue

Properties dialog box.

Square Sizes

The puzzle and solution sizes are given in millimeters. The grid is displayed on screen at the puzzle size,

modified by the Zoom setting. Due to the low resolution of computer screens small changes in sizes may not

show up on screen, but they will when you print the grid.

Size % of squares

Change these settings to modify the relative sizes of the lines, bars/border, numbers and letters in each

square. The same setting is used for the thickness of bars and the puzzle border (if you select Thick puzzle
border).
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Advanced properties

Block Style

Select Italian block style to use blocks that do not entirely fill the square, as used in many Italian crosswords.

Change the Margin % setting to change what width the non-filled margin is as a percentage of the square

width.

Double Clicks

This setting determines what happens when you double-click on a square or line in the grid. If Allow Bars is

not selected bars will never be inserted, regardless of how close to a line you click. If Allow Blocks is not

selected you can insert bars by clicking only very approximately on the grid line. This is useful if you find it

difficult aiming for a narrow grid line when you want to insert a bar using the mouse.

Word search words

This setting determines whether words are circled or marked by single lines. Note you can only use circles on

Windows 2000 and higher.

Number sizes of grid

Select this option to number the top and left sides of the grid, outside the grid.

Grid side numbering

This determines whether Roman numerals, letters, or numbers are used for the numbering. These settings are

also used if you select clue numbering by position in the Clue Properties dialog box.

Copyright under grid

If this setting is selected, the puzzle copyright (set under File, Information) is shown directly underneath the

grid, and is included with the grid when exporting a puzzle or printing. You can set the text size as a

percentage of the grid cell size. By default, the copyright is only included underneath the puzzle, but you can

also check the box to show in both puzzle and solution.
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Clue Squares

You can set the default number of lines for clues in clue squares, and also whether dividing lines should the full

width of the clue square. By default, the vertical spacing of clues is optimized to allow enough space around

character accents and descent, select Space vertically independent of content if you want the spacing to be

based just on the number of lines not on the specific content on each line (which gives identical positioning of

lines on squares with the same clue-line-divider distribution). By default, clue squares and arrows are not

shown in the solution; to change this check the Show in solution box.

Default block type

This determines whether a clue square or a normal block is inserted when you double-click or press Spacebar

on a square.
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Arrow style

On the Arrow style tab you can customize the shape, size and position of the arrows used for clues in

squares puzzles and continued words. All dimensions are specified as a percentage of the square size. Check

the Use for continued words box if you want to use the same arrow settings for continued words (otherwise

they appear using large arced arrows).

Arrows are required by the program to link words to clues. However, if you don't want to actually show them in

the published puzzle you can select the Don't show clue square arrows option.
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Square Properties

You can change the properties of a square in the grid by moving the cursor onto the square and pressing

Alt+Enter or clicking on the properties icon ( ) on the toolbar. You can change the properties of many squares

at once by first selecting a number of squares in the grid (or use one of the Select All options on the Edit
menu).

The left-hand side of the dialog box shows a preview of what the square looks like in the puzzle and in the

solution.

Square Type

This shows the type of the square. Click on one of the buttons to change the square type.

Format

Change these settings to determine the background and letter color of the square. The options available

depend on the type of square whose properties you are changing. The default colors for blocks and letters are

set in the Grid Properties dialog box, change these if you want to change the settings for all the squares. If you

select the Custom item from the drop-down color lists you will be presented with a color selection window to

select any color of your choice. Check the Circle box to have a background circle of the given color rather than

coloring the entire square.

Click the background picture button to insert an image file to use as a background for the square. If the

square is a letter square you can check the Rebus box to make the background image show only in the

solution, to have the square blank in the puzzle, but to have Display Letters that give the letters for the rebus.

(e.g. you might insert a picture of a cross to replace the display letters 'cross').

Formats in solution, Formats in Puzzle

These options determine whether the colors and bold/italic setting you have selected are used in the

solution and/or the puzzle.

Main central text

For letter squares, here you can edit the letter or letters that appear in the square. Usually a square has only

one letter, but multiple letters can be useful for making rebus puzzles.

Letter visible in puzzle

Check this option to make any letter in the square appear both in the puzzle and the solution. This is

useful if you want to give some the solution letter to some of the squares in the puzzle as a starting hint.

Numbering/corner text

The default numbering follows the setting in Grid Properties. Check No across clue or No down clue if for

some reason you don’t want to have any clue associated with the given word. The square will not be

numbered if no clue starts at that square. Set the Top left text (after unchecking Default numbering) to
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specify a custom square number, or Top right text to have an additional number (or other text) at the top right

of the square.

Blank in puzzle

Select this option to hide all contents of the square in the puzzle. This is useful for creating skeleton

crosswords where people have to fill in the blocks and numbers as well as solve the clues.
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Clue Squares

Clue squares are squares in the puzzle grid that contain short clues for surrounding words.

You can insert a clue square into the grid by double-clicking, or double-clicking while pressing Alt (depending

on the setting in Grid Properties) To edit the clues in the square, and to change the arrows which come out of

the square, place the cursor on the clue square and press Ctrl+E or click on the Edit Clue button on the

Toolbar.

The Clue Square Editor

Entering clues

You can enter the clue or clues in the central square of the dialog box. The maximum number of lines is set in

the Font Size box. Press Enter to end a line, and use a hyphen, alone on a line, for a horizontal line. So for

two clues separated by a line you would enter

Clue 1
-
Clue 2

In the grid the '-' will be converted to a full line. To fit more lines of text you can increase the lines per square.
Using a half-integer number will use closer spacing around the line separating clues, allowing a slightly larger
font to be used for the same number of lines of text.

The text you enter can either wrap onto the next line if it is too long, or the font size can be decreased to fit it.

Click the small wrap button at the bottom left to toggle between the two modes.

To use a clue from the database press the Use clue button. To look up a word that you haven't just clicked the

arrow for, double-click on the word itself.

Assigning arrows

Click on the arrow buttons at the size of the square for the arrows that you want. When you press an arrow

button the word in the direction of the arrow is shown and any clues in the database for that word are also

displayed. To add a diagonal arrow from a corner of the square, press the '+' button at the top right and select

the arrow/word combination that you want. Arrows are only shown if there are corresponding word slots to link

to.

Click the up/down arrows by the Left and Right clue buttons to move them up or down, or drag them where

you want. This is useful to align the arrows with the position of the corresponding clue in the square.

Reviewing and formatting

When you have finished editing the clues press Enter, and you will see your clues appear in the square in the

grid. Be careful to make sure that you don't write more than one clue for a given word, and that each word in

the grid has a clue square with the arrow pointing in the correct direction.

The default number of lines (font size) is set under the Grid menu, Grid Properties, Advanced. There is also an

option there for whether you want the dividers to be the full length of the clue square or not. The Arrow style
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tab of Grid Properties lets you customize the size, shape and position of the clue square arrows. Arrows are

important to link clues to words in the grid. However, if you don't actually want to show arrows when published,

there is a setting in Grid Properties (Arrow Style tab), to only show them while editing.
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Grid Font

You may change the font used to display and print the grid and clues by selecting Font... from the Grid menu.

You are recommended to choose scalable fonts like True Type fonts for best results. To set the size of the font

in the grid change the Size % of squares setting in the Grid Properties dialog box.

The font used for the clues is set separately in the Clue Properties dialog box.
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Block filling

British-style puzzles, in which words are linked every alternate letter, have a regular pattern of blocks. You can

quickly fill in the basic pattern by choosing Fill Blocks from the Grid menu.

Block filling fills in every alternate block on alternate rows. There are four choices of starting position - just

select the button for the one you want.

Note that fill from (2,1) and (1,2) is not compatible with dual-symmetry.



40

Puzzle flipping

You can flip a puzzle to its mirror image by selecting Flip Pattern from the Grid menu. This has no effect other

than the numbering and order of the clues, and the appearance of the puzzle. You can undo a flip by doing

another flip. Here is a puzzle, one before and one after a flip:

←→

You can't flip a puzzle that contains linked clues or clue squares.
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Convert to outline/shape

To remove all block and empty squares in the puzzle to make an outline puzzle select the Convert to
outline/shape item on the Grid menu.

You can also make an outline puzzle directly by setting the option on the Options tab of the Create Vocabulary

Puzzle window.

This features gives a puzzle with an outline that goes round every filled square, allowing you to create free-

form puzzles. You can toggle a square between being removed and blank by pressing Ctrl+Delete with the

cursor on the square. Here is an example of a puzzle before and after converting:
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Linking word slots to make one snaking word

You may wish to have one long word or phrase in a grid that snakes around. You can do this by placing the

cursor in the word slot that starts the snake, setting the typing direction to the direction of the word, and

selecting Continue word down or Continue word across from the Edit menu. An arrow will be added at the

end of the word to indicate the direction in which the word continues. You can undo the link by repeating the

above sequence.
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Key words

In a word search puzzle the key words are the words hidden in the grid. A standard puzzle can also have a key

word: it is some set of circled squares that spell out an additional word or phrase. To view key words see Key
Words on the Words menu.

To add a keyword to a grid select the keyword icon on the toolbar. To select a word in a word search then just

click on the grid and move the mouse while holding the mouse button down; a circle will be drawn between the

first square you clicked on and the current mouse position (assuming it is a straight line). For separate circled

squares hold down the Ctrl key and click on the grid squares that you want to make up your key word.

When you export an interactive puzzle the key word squares will be shown separately below the grid, The

color used is set in Grid Properties.

There is an option in the Key Words window whether to Circle in puzzle or Circle in solution. Word search

words are circled in the solution. Usually other key words are circled in the puzzle.
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Using a pattern in a grid library

Select Use grid library from the Grid Library submenu of the Grid menu to use a pattern from a grid library

with the current crossword. This way you can use previously designed grids rather than editing the pattern of

squares by hand.

Click on the grid library you want to use at the top of the window and then select one of the available patterns.

If no patterns are listed then there are no available patterns for your current grid size. When you select a

pattern it will display in the crossword. Click OK when you have selected the one you want to use.

If you cannot see all the grid behind the use pattern window you can click on the Minimize button at the top

right of the window to minimize the window so that you can see all the grid.

You can delete or rename a pattern from the library by selecting an item from the right-click popup menu. You

can also delete an entire grid library by selecting it and pressing Delete (but you cannot delete any of the

supplied standard grid libraries).
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Adding to a grid library

Select Add to grid library from the Grid library submenu of the Grid menu to add the current grid pattern to

a grid library.

Just select the grid library you want to add the pattern to, type in a name for the pattern if you don't want to use

the default name, and press Add. If you want to add the pattern to a new library click the New button, type in a

name for the new library, and then add as before.

You can then use your grid pattern when you make a New Puzzle or by selecting Use grid library from the

Grid menu. You can also delete a grid library or rename a grid pattern by using the Use grid library window.
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Extracting grid patterns from files

Select Add patterns from files from the Grid Library submenu of the Grid menu to add all the grids from a

batch of files to a grid library.

Select the files you want to extract grid patterns from. Then select the library to add the patterns to and enter a

Grid pattern name. You can use the placeholders %W for the number of word slots, %B for the number of

blocks, %C for the number of letter squares in the grid, %N for the number of the grid added (i.e. 1,2,3... up to

the number of grids you add), %L for a word count of the three longest word slots, %Ln for a words count of

the n longest word slots, %Xn for the count of words of length n, and %F for the source file name. Click on

Add and you will be asked whether you want to suppress duplicate grids. The program will then open each file

in turn and add each grid to the grid library that you selected.
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Creating Vocabulary Puzzles

To create a freeform puzzle from a list of words select New from the File menu and click on the

Freeform/Vocabulary button. The vocabulary puzzle builder inserts blocks (black squares) automatically in

unused squares. If you want to fill in words around a given pattern of blocks, use the Fill Grid feature instead.

Select Create vocabulary puzzle option on the Words menu to fit words into an existing grid. For example,

you may wish to design a particular shaped puzzle, or seed the grid with a few words before filling in the rest.

The tabs along the top of the Create vocabulary puzzle window give you different ways to specify the words

that you want to use:

Use Words

Type in some words to use or select a Theme List and click on Build Puzzle. You can write the clues for

the words that are used later on. This saves you writing clues for words that end up not being used.

Use Words with Clues

Type in words with clues, or select a clue database that you’ve made before, and click on Build Puzzle.

This saves you having to do any extra work after you’ve built the puzzle. However, you can’t take

advantage of the advanced features of the Clue Editor if you do this.

Use Word List

Select one of the main Word Lists to use and click on Build Puzzle. You can write the clues later.

An example: say you wanted to create a 6x6 puzzle containing names of common metals. In the create

vocabulary puzzle window you would select the Use Words button and type in, say,

iron

gold

tin

lead

copper

silver

nickel

zinc

Click on the Build Puzzle button and the computer will automatically generate the puzzle:
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To accept this puzzle press the Accept button. If you don't press Accept the computer will continue to search

for puzzles that contain more of the given words. Press Accept whenever you are happy with the result

produced.

If you don’t like the puzzle, and the computer is not finding any more fills, you can press the Next button to

randomly start generating a different new grid. You can press the < button to view previous fills, and Accept to
decide which one you wish to use.

You can cancel the fill at any time by pressing the Cancel button. This will let you edit your word list and re-

start the fill, or cancel entirely.

If you find that not enough of your words are used then try a bigger puzzle - change the puzzle size by clicking

on the Size button. If the words fit easily and there is too much blank space you may also want to try

decreasing the puzzle size. When you press the Size button there are options to increase or decrease the size

by two squares, or change to any size you like. [This option is only available if the starting grid is blank.]

Now for some more details on the various options:

Use Words

If you select the Use Words option you can save your list of words as a theme list by clicking on Save As
on the Action button. You can then use your words just like any of the other theme lists. Other useful

functions are also on the Action button, for example to clear the word list or load words from a text file.

If you select a Theme List to use you can edit or add words to the list. Click the Save changes button if

you want these changes to be automatically saved in the Theme List. You can also use the Save button

on the Action menu to save changes at any time.

Use Words with Clues

Type in your words in the left column and the clue on the right. Use the Action button menu items to

delete everything and start again, or to save, sort or load from an external file. To use a clue database

select one of the available databases in the Use Database drop down list.

Use Word List

The available main word lists are listed - just click on the one you want to use. Set the Minimum word
length to a number higher than two if you want to avoid short words. Set the Minimum word score to

avoid words with scores less than the given value.
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Options

There are various options available to customize how the process works. Select the Options button at the top

of the window to change them. The options you can change are as follows:

Surrounding squares

This setting determined what the computer puts in the squares in which there are no words. Select Blocks to

create puzzles like those above, or select Voids to create a freeform outline puzzle. With Voids selected the

puzzle above would look like this:

Allow adjacent parallel words

This option determines whether junctions like

are allowed or not. Here OPEN and NEAT count as adjacent parallel words, as do TEN and NEAR. With large

word lists disallowing this kind of junction will make the fill significantly faster.

Equivalent letters

Many puzzles show letters in upper case with accents removed, so letters can intersect irrespective of case or
accents. If you want to preserve accents or case, change the setting here. This may be particularly useful for
educational/language-training puzzles, or if using a language where accented characters are regarded as
separate letters. This setting only affects theme lists and directly entered words; word lists have their own letter
mapping settings.

Avoid word and sub-word

This option prevents similar word forms being used. For example if your word list contains Britain and Great

Britain this would prevent both being used. Similarly, only one of cat and cats would be used.

Avoid duplicating substrings

This option is similar to the above, but can be used to avoid more general repetitions of word substrings. For

example 'Freeboarding' and 'Surfboard' have the five-letter substring 'board' in common; using this option with

a length of five or less would ensure that only one of these two words is used. This option cannot however

avoid irregular derived words that are similar, for example think and thought.

Clue database usage and avoiding repeats
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If you use Use words with Clues and save the words and clues as a Clue Database, you can get the

database to track which words are used and avoid repeating them in the future. Select the Tag used clues
with date option to mark all clues used in the current puzzle with a date (by default, today's date). To avoid

repeating words, select the Avoid date tagged clues box; by default this will avoid all clues that have

previously been date stamped. Alternatively, you can select a Later than date, to only avoid clues used more

recently than the specified date.

Save your settings

You can save the settings in the window by clicking the Save options button so that they will be automatically

selected next time you start up the program.

Notes

If you have made a puzzle and saved it, but later realize you made a typo, you can select Create Vocabulary
Puzzle on the Words menu to get an option to extract the words and clues, edit them, then rebuild the puzzle.

Note that when you create a vocabulary puzzle the grid symmetry is automatically changed to None.

Making multiple puzzles from one list

If you have a word list or list of words and clues, and you want to make several puzzles using as many of your

entries as possible, follow these steps:

Make the first puzzle as normal, and finish/save it.
Start a new puzzle, and in the Create Vocabulary Puzzle window click on the Action button and

select Remove words used in last fill(s)
Fill the puzzle using the word list, which has now had previously-used entries removed
Repeat until you have generated as many puzzles as you like

Note that the previously-used word list is only maintained for one program session. You can use the item on
the Action menu to reset the used words list if you want to start over. When making a puzzle from words with
clues, saved in a clue database, you can instead date stamp the clues being used as described above (Clue
database usage and avoiding repeats).
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AutoFind

Use AutoFind to find words to fit in the puzzle. Click the toolbar icon ( ), select AutoFind from the Words
menu, or click the right mouse button on a square in the word slot that you want to fill. Words are found to fit in

the current typing direction, but if there is only one possible word through the cursor's square, words are found

to fit in that direction.

For example if you had a puzzle that looked like this:

You may want to find a word to fit down the middle. Click with the right mouse button on one of the squares, for

example, above the 'D', to pop up a list of words that fit. Simply scroll through and select the word you want

and press Insert. When you select a word you can see it in the grid in grey. If you selected the word admiral
then the puzzle would look like this:

If AutoFind doesn't immediately come up with a suitable word you can search in any of the other word lists you

have set up by clicking on the tabs at the top of the AutoFind dialog box. The word list that is used by default,

and the word lists that are displayed, can be changed by selecting Change list usage... from the Words menu,

of the Settings icon button at the bottom of the AutoFind window.

To find words matching a certain pattern use the Find Word... command on the Words menu. To find a fit for

whole sections of the puzzle (rather than just one word at a time), use the AutoFill command on the Words
menu.

If you want to find words of various lengths that would fit in the grid you can use Shift+Alt+A, or Ctrl+Right

Mouse to bring up the Find Word dialog box set with the word pattern at the current cursor position.

AutoFind can also show only words which, when inserted into the grid, will not cause impossible letter

combinations. To show only words compatible with their intersecting words, click the button in the bottom-left

corner of the AutoFind box. The word that is compatible with the most intersecting words in the default word

list will be selected. You can show only compatible words by default by changing the setting under Change list

usage. To show all the words that will fit regardless of the intersecting word slots just press the button again.

If your search comes up with a word that you want to remove from the word list just select the word and press

Delete. It will be removed form the word list in which it was found. Alternatively you can right-click on any word

to edit it, change the score, delete it, or add to and remove from specific word lists.
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You can also use AutoFind on a complete word in the grid. If the word is not in the selected word list there is

an option to add it.

The font used for displaying the words can be changed under Preferences.

AutoFind (any length)

Select this option from the Words menu, or press Shift+Ctrl+A to find words that will fit in the current word slot,

including words not long enough to fill the entire slot. Select a word and click the Insert button to paste a word

into the grid. A block (or bar) will be inserted at the end of the word if it is not long enough to fill the entire word

slot.
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Find Words

If you want to find words that match a specific pattern you can use the Find Word... command on the Words
menu.

Enter a pattern as the search word, and it will then find words that match, e.g.

T???SH
finds THRASH, THRESH and THRUSH

AP*X
finds APEX, APPENDIX and APTERYX

?*Q*P
finds ACQUAINTANCESHIP, EQUIP and REEQUIP

Use * to stand for any number of letters, and ? for one unknown letter. You can also use groups of alternative

letters, just include the group within square brackets. Use @ to stand for any vowel and # to stand for a

consonant. Use ^ as "not" before a letter or group. E.g.

[QZ]*[QZ]
finds QUARTZ, QUIZ, and ZIZZ

#######
finds RYTHMNS

P@#@#?LLY
finds PITIFULLY and PIVOTALLY

Q^U*^S
finds QATAR, QINTAR, and QOPH

CO*^[LN]ESS
finds COMPRESS, CONFESS, CONGRESS, and
COUNTESS

* can stand for any number of letters, including no letters. If you wish to find a word starting with an L and

ending in an N at least two letters behind the L, you can enter *L??*N. This will find, for example, ALIEN
which has two letters between the L and N, and ALLERGEN which has many letters between them. *L*N
would include words like KILN in the list, where the L and N follow each other.

Force punctuation (;); Put a semicolon at the start of the search pattern to force the matched words to have

exactly the punctuation of the search pattern. Otherwise, it will be punctuation insensitive. E.g. ;????? finds all

five-letter words without any punctuation. ????? on its own would include words like at bay.

Case sensitive (:) Put a colon at the start of the search pattern to make it case-sensitive.

Regular expressions: (\) Do powerful regular expression searches by prefixing the search pattern with a

backslash (advanced users only!)
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By default the found words are sorted alphabetically. Select the sort by length option if you prefer them to be

sorted by length (shortest matches first).

You can set the minimum and maximum word lengths of words to find by changing the settings in the relevant

box. Once you have entered a search pattern you can look in any of the available word lists by clicking on the

tabs with the word list names.

To change the letters which are counted as vowels (the @ symbol), right click anywhere in the Find Words
window except on the list box, and click the Set vowels... menu item. Enter the letters that you want.

Consonants are defined as non-vowels (e.g. # equals ^@).

If you select one or more of the found words you can press the Copy button to copy it/them to the clipboard, or

if you used Find Word with the cursor in a suitable slot in the grid you can Insert the word directly. If you copy

a word with the Clue Editor open you can then paste it into the Clue Editor as part of a clue.

If you want to find words to fit in the puzzle it is easier to use the AutoFind facility.

You can save the found words to a text file by right-clicking on the list, selecting Save found words..., and

entering a name for the file to save them to. Alternatively select Copy all to clipboard from the same right-

click menu. You can select multiple words by holding down the Ctrl key while you click on different words; the

right-click then offers an option to delete or copy the selected words.

If your search comes up with a word that you want to remove from the word list just select the word and press

Delete. It will be removed form the word list in which it was found.
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Using AutoFill to fill a crossword

You can fill in complete puzzles, or sections of puzzles from a word list using the AutoFill command on the

Words menu. You can also click on the AutoFill icon ( ) in the Toolbar or press Ctrl+A.

AutoFill fills in the grids with the default settings in the Fill Grid dialog box.

For more information about grid filling see Filling words in a crossword grid .
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Filling words in a crossword grid

Select Fill Grid... from the Words menu to bring up the Fill Grid dialog box with options for filling in the word

slots in a grid. If you just want to fill the grid using the default options use the AutoFill command.

An example

If you had a crossword that looked like this:

you could place the cursor next to the 'E' in 'STICKER', and invoke AutoFill or Fill Grid, to get a complete

crossword. For example

You can also fill in a totally blank grid, but you must finish designing the pattern of blocks before using Fill Grid

(see the edit topic for help with this, or use a Grid Library). If you want to let the program design the grid and

use just a short list of words then use the Create vocabulary puzzle feature instead.

See The Professional Grid Filler topic for details of advanced options and manual word selection.
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Filling the grid

During the fill

Once you have set the options press the Fill button, and the fill will begin. You can cancel at any time by

pressing the Cancel button, or stop the fill, keeping the filled letters, by pressing Stop.

If a fill seems to get stuck in one part of the grid, or you don’t like a letter that has been used, you can click the

Refill button (or Refill from beginning on the drop-down menu) to start the fill again from the beginning with a

different random start word.

The Refill button drop-down menu also has other options. Select Refill with new options to cancel the fill and

change the options for the fill.

When the fill is completed

Once the fill is complete you can either press the Accept button to accept the fill, Cancel to abandon the fill, or

click on the Refillbutton (or one of the drop-down options) to refill. Click the Words used button to show the

words used window with a list of all the words in the grid and give you an option to restart the fill from/without a

specific word. Select the Check similar words menu item on the drop-down menu to analyse the words in the

grid for repeated sequences of letters. This is useful if you want to avoid using two words that are similar but

not identical.

Use the Previous and Next arrow buttons to move between successive fills. Pressing the Next button will find

the next possible fill. With many grids this will mean just changing the last few words used. However, if you are

filling a tight corner this can be useful to quickly view all the possibilities. If you have created several fills, either

by pressing the Next button or by refilling parts of the grid you can view previous fills by pressing the previous

arrow button. Select Delete fill from the drop-down menu if you don’t like the current fill and want to delete it.

The fill is deleted and the next fill that has already been found will be shown.

The Pro Grid filler also has advanced options for non-stop filling: finding the best-scoring set of possible fills.

Select these options from the non-stop filling menu option, and then navigate the possible fills using the

arrow buttons as above.

You can use the left and right cursor keys to quickly move between fills. If you hold down the Ctrl key at the

same time the current fill will be deleted and the next or previous fill will be shown.
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Options

Change the following options in the Fill Grid window to customize the filling process and set the default

settings for AutoFill.

Base word list

Select the word list that you want to use in the Word List to use list box. The words in this list that will be used

for filling the grid (but see 'using theme words' below).

Optimization

Each of the words in a word list has an associated score. By using the optimization options you can vary the

number of 'good' and 'bad' words filled into the crossword. Weak optimization is quite fast, and will give you a

significantly higher average score than using no optimization. Strong optimization will give you a significantly

higher average score than weak optimization if your word list contains only a few highly scored words. Set

optimization to Theme Words if you want to create a thematic crossword. Select Fill reliability if you have a

particularly hard grid to fill. This makes the fill progress more slowly, but with difficult grids the fill may finish

sooner that with the other optimization options.

Change the Minimum word score setting to avoid words with scores less than this score. This allows you to

avoid obscure words altogether if you want to. (see the topic on word scores for more information).

Using theme words

The grid filler can try to maximize the number of theme words that are filled into a grid. Set the Optimization
option to Theme Words and select a Theme List or main word list to use as a theme.

The filling program will use as many of the theme words as it can, but when it can't use a theme word it uses a

word from the Word List to use. This is a good way of creating a themed crossword when the theme word list

contains too few words to fill the grid directly. Also see the fit theme words feature if instead you want to select

and use a grid pattern that will fit all of a short list of theme words.

Select Weak theme only to use fewer of the theme words if you want only a few theme words.

Pangrammatic fill

Select this option to ensure that the filled grid contains every letter of the alphabet. The alphabet used is set in

the Clue Properties dialog box. The filler will only use words containing letters of the alphabet, and each letter

will appear at least once in the completed grid.

Save as settings for AutoFill

Select this option to save your options as those used for AutoFill and as the default settings for the next time

you use Fill Grid. Fill settings are stored with each puzzle. You can then save the puzzle as a template if you

want to use your settings for crosswords you create in the future.

For maximum control over which words are used in the grid you may prefer to use AutoFind repeatedly, and

choose exactly which word you want in each word slot yourself, or you if you have the Professional Grid Filling
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module you can select Manual word selection to have complete control over which words are used.
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The Professional Grid Filler

The features described here are only available if you have purchased the Professional Grid Filler add-on, or

one of the Professional bundles.
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Manual word selection

Select this option under Fill Grid on the Words menu to give you complete control over which words are used

in the grid filling processes. When you start the fill you will be prompted for which of the possible words to use

in each word slot. See Grid filling with manual word selection for more information.
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Fit theme words

In the Create New puzzle window you can choose, and then fill, a grid based on your choice of theme words.

See the Fit Theme Words topic for details.
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Fill from database

The Fill Grid window has an option to fill directly from a clue database rather than a word list.



64

Fill using multiple word lists

In the Fill Grid window you can select more than one main word list to use; it will combine all the words in the

selected lists when doing the fill. To select more than one list you can hold down the Ctrl key while clicking on

the lists you want to use.
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Word scoring options

Select the Scoring tab of the Fill Grid window to set different minimum word scores for depending on the word

slot length. This can be useful to ensure you have 'nice' words in the most prominent or longest word slots.

You can also pre-select slots in the grid (before using Fill Grid) and set a custom minimum score just for those

slots.
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Rebus and special fills

Select the Special tab of the Fill Grid window to set specific sequences of letters to be use as a Rebus - i.e.

letters that appear in a single square. For example, if you use cat as a rebus, any word with the letter

sequence cat will appear with cat in a single square. So a word like 'catch' would only take a 3-square word

slot.

In the Letter/word substitutions box you can also make general substitutions (without putting more than one

letter in a square) for making a variety of novelty fills. Enter each substitution in the form 'X=Y', where X is the

letter or letters that you want to replace, and is the thing to substitute. The right-hand side (Y) can be blank if

you want to do letter/word deletions.
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Advanced filling options

Select the Advanced tab of the Fill Grid window to set various options for the filling process.

Option to view partial unsuccessful fill

Sometime the filler may not be able to find a fill. Select this option if you’d like the option to save the best effort

(with maximum number of words it was able to fill).

Exhaustive recursion

Select this option to make the filling process try out every possible combination of words until it finds a fit or

gives up. In this case the filler will never give up if a fill exists (actually there is still a very small probability of a

false fail, but it’s less than 0.01% for almost all cases). The trouble with exhaustive recursion is that the filler

can spend a lot of time ruling out rather unlikely situations. Deselect this option to use a non-exhaustive filling

method that will spend less time ruling out unlikely possibilities. The downside is that the fill may then fail even

though there is a possible solution.

Next word must be linked

Select this option to make the filler choose the next word slot to fill one with at least one intersecting word. If

this option is deselected the next word slot must only have at least one intersecting word on one of its

intersecting word slots.

Start filling from cursor position

Select this option to make the filler start filling from the word slot at the current cursor position. If you deselect

this option the filler will analyse the grid and start filling from wherever it thinks is best.

Prefer filling longer words first

This option biases the choice of the next word slow to fill more towards long word slots. Use this if you prefer

filling longer words first.

Show all matches at once with manual fill

If you select this option the Manual word selection window will list all possible words for each word slot,

irrespective of the settings just below. When this option is not selected, only a subset of the words are shown

(starting at a random place in the alphabet), which can be faster on slots with many matches.

Max words to find in one go

This sets the absolute maximum number of possible words for each word slot that the filler will find. If you are

using Manual word selection this will also be the maximum number of word choices that you are presented

with (unless you select the option above). With Automatic word selection the higher the number the faster

the fill. However, higher numbers use up more memory, so use large number settings with caution. When you

first ran the program the setting was set to a value likely to be OK with the amount of memory your computer

has. Increase the setting if you install more memory or don't mind Crossword Compiler using up a large

proportion of your memory. Higher settings also result in better score optimization.
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Possible words/buffer size ratio

The actual maximum number of words found for each word slot is determined by the Max words to find in
one go (M) setting, the Possible words/buffer size ratio (P) setting and the number of words in the word list

of that word length (N). If N divided by P is greater than M then the maximum number found will be M,

otherwise it will be N divided by P.

Avoid repeating substrings in different words

With this option turned on, the filler will never use a word when that word contains a string of letters that have

already been used elsewhere in the puzzle. The length of the substring to check can be changed in the

Avoided repeated substrings of length box. If this option is turned off, the program will still avoid duplicating

words, but it won't for example avoid using "word"; and "words" in the same puzzle. This setting can also be

used by Grid Insight if saved as your default autofill settings for the current puzzle or template.

Select the Save advanced settings as default box to save your settings to be used every time you fill a grid

every time you use Crossword Compiler. Otherwise, your settings will be lost when you close Crossword

Compiler.
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Exclude

You can use word scoring to avoid lower-scored words, and ignore words below your minimum word score. On

the Exclude tab you can also avoid other words when filling, which may be useful if you are using un-scored

word lists, or wish to avoid words that you have used recently.

Exclude words from blacklist will avoid vulgar/offensive/medical words in the blacklist that are not usually

acceptable in standard puzzles. In the default list these will also be excluded by setting a minimum word score

of 11 or higher, but the option can be used with anz list or combination of lists.

Exclude words from database can be useful to avoid words that you've used recently, i.e. by excluding

words that you've recently added to a clue database. You can select to exclude all words in a specific

database, or only words added after a specific date or in the last given number of days. After finishing a

puzzle, you can add the words and clues used to a database using Add puzzle clues to database; for

subsequent fills, you can then choose to exclude those words with a recently-used date.
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Threads

The filling engines can make full use of modern computers, exploring multiple fills at once. The Threads tab in

the fill grid window allows you to limit or fine-tune the resources that are used. For most users the default

automatic setting should be fine. You may wish to reduce the number of threads if you want more of your

computer free for other resources, or to keep it running cool, etc. Increasing the number of threads may in

some cases be helpful if you want to explore many different solutions to a difficult fill at once but your computer

does not have many CPUs. Using more threads allows more different initial starting words to be tested,

potentially finding a fill faster than doing fewer deep searches.

Multiple threads are also used for Manual Word Selection, to check the fillability of the remaining grid and find

the forced words. Using the Automatic setting, or number of threads equal to the number of CPUs, will

generally give the fastest results.
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Timing

The Timing tab in the Fill Grid window allows you to fine-tune how much time the filler spends doing various

parts of the search. Changing these settings allows you to fine tune the trade-offs between getting rapid results

and getting early identification of an impossible fill. If you don't want to worry about the details, the defaults

should be fine for most people.

The first setting applies to all fills, and determines the time the filler spends analysing an initial partially-filled

grid before attempting to continue filling. Increasing this number will make the filler slow to start, but in difficult

fills will make it less likely that tight constraints in different areas of the grid later lead to dead ends. The default

should be fine for rapidly identifying a local area that's impossible to fill.

The remaining settings apply to Manual Word Selection, and determine whether the filler does a deep check of

each possible fit - taking longer to study all the words - or does a shallower search allowing all words to be

checked more quickly. The checking happens in two steps: a 'quick' initial check, which can often quickly rule

out many words, and a deeper check that can identify more difficult problems. There are separate settings for

tweaking timings for identifying locally-forced word choice, and for deep checking whether a full fill is possible.
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Saving and re-using fill configurations

Using the Fill button's drop down menu option, you can save a set of fill settings with a name for easy re-use.

The saved settings can be used by selecting them from the drop-down menu, and can also be accessed

quickly using the drop-down menu on the AutoFill button on the main toolbar.
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Grid filling with manual word selection

Select Manual word selection when you fill a grid to manually choose each word to be used. (This is only

available with the Professional Grid Filling module, and can also be accessed using the drop-down menu from

the AutoFill button on the main toolbar). Using this feature you have complete control over which words will be

used by the grid filler. This is much better than inserting words by hand (using Find Word, say) since you can

take advantage of the grid filler’s powerful look-ahead to reduce the number of times you have to replace

words you’ve already put in the grid. The filling engine will automatically determine a good filling sequence for

you, however you can click in the grid to re-direct the fill if you want to fill a particular slot next.

For each word slot, the filler will show the various words that will fit. It will also start checking them for

consistency with intersecting words, whether they lead to forced words in other slots, and whether a full fill is

possible or not. Once an initial fast check is completed, the word is marked with a red check mark. If the filler

has determined that a full fill is possible using the word, the check mark changes to green; this may take a bit

longer, especially on hard-to-fill grids. Words that lead to impossible fills are removed from the list as soon as

this is determined.

The Word Selection window

The Word Selection window has three pages. Click on the tabs at the top to change the page. You can use the

buttons at the bottom to Cancel the fill, Stop the fill or make the fill Start Over from the first word slot. Click

the Auto pick button if you want the filler to continue by choosing words automatically. You can press the

button again to revert to manual word selection. When the fill is complete you can use any of the buttons on

the main toolbar exactly as when using Fill Grid with the automatic word selection.

The Word selection page

On the Word selection page you get a list of all the words that will fit in the current word slot. Whilst you are

viewing the words the filler performs a background analysis of the words and removes ones which are no good

(i.e. would make it impossible to fill nearby word slots). At any time you can select a word and press the Use
Word button to insert the word into the grid and move on to the next word slot. When the background check is

complete the header of the word column says “all checked”

As the background analysis finds Forced Words in other word slot, it shows them in the box at the bottom.

These words are also shown in the grid. Just change the selected word to view the forced words of each word.

The score of the forced words is listed in brackets after each word. Not all the words listed will necessarily

have the same number of forced words - in many cases there will be some choice in the nearby words. Click

the >> button to show the choices for nearby words. Note that the choices listed are the most choice you will

ever get. It’s quite likely that by the time you come to chose one of the words the number of possibilities will be

rather less. You can delete a forced word by selecting it, right-clicking and selecting the option from the popup

menu.

To view clues in the current clue database click the Show clues box. Clues available for the selected word will

be shown in the bottom panel. Double-click on a clue to use it with the selected word.
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If you don’t like any of the listed words and want to go back and replace the previous word press the Back
button. If there is a word listed which you don’t like and want to remove from the word list then select the word

and press the Delete word button (you will be prompted if you want to permanently delete the word from the

word list once the fill is complete). To look up a word in a dictionary press the Lookup button (you can also

select one of the forced words to look that up instead). This will pop up a menu listing all the installed

dictionaries; just click on one of them. Click the More button if you want to see more words that will fit in the

word slot.

Next to each possible word is listed a score and fill score in separate columns.

The Score is just the score of the word plus the score of any words that will have no remaining intersections

after this word slot is filled. For example, if one of the words is HAPPY and the Y would make the last letter in

the intersecting word PLAY then the score would be the sum of the word scores of HAPPY and PLAY. The

possible words are listed in order of the total score.

Before the background analysis the Fill Score is just some ad hoc measure of how easy the word would make

the remaining fill. After the background analysis the Fill Score is based on a combination of two measures.

Most of the score is a sum of the maximum word scores available in the intersecting word slots if the word

were used. The remaining part of the score is a measure of how easy the word would make the remaining fill.

So generally the higher the Fill Score the better. When the background analysis is complete you can resort the

words in score and then fill score order by clicking on the score column header (or select the option on the

Options tab to resort automatically). Note the fill score does not account for word slots outside the

immediately-intersecting region.

The Fill sequence page

Click on the Fill sequence tab to view a list of all the words that have been used so far.

If you decide half way though a fill that you need to go back and change an earlier word you can select it in the

Fill sequence list and press the Refill from button. This will undo all the words back to the selected word and

offer you the alternatives available for that word.

The Options page

Click on the Options tab to customize aspects of the manual filling process.

Change the Selected background color to change the color of the highlight of the word slot in the grid that is

currently being filled.

Check the Resort words on completion of background check box to automatically resort the possible

words once the filler has determined a more accurate Fill score for all of them. The words will be resorted

firstly by score, then by Fill score, and then alphabetically.

Sometimes when you come to fill a word slot there is only one possible word that will fit. Change the

Automatically insert single words option to control whether the filler will automatically insert single words

without prompting.

Click the Save button to save your settings to be used every time you use Manual word selection.
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The font used for displaying the words can be changed under Preferences.

Deleting words and changing scores

If you see a word that has a wrong score or should be deleted, you can right-click and select Change word
score. # You can also change the score in multiple lists by selecting Change score in.. and selecting the lists

that you want to change.

To delete a word, press Delete or click the Delete button as explained above. To delete a word from
multiple lists, select Delete from... from the Delete button's drop-down menu.
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Placing theme words

This function is only available if you purchased the Professional Grid Filler (order online).

Some standard puzzles have a few themed words in the grid. The Fit theme words feature is designed to

help you chose a grid and place some theme words. The feature scans all the available grid patterns for your

chosen grid size and works out which grids can fit all of your theme words. It then shows you the words in

possible arrangements in the grid and lets you test-fill around them.

To use the theme word placing feature start a new crossword as usual and press the Fit theme words button

in the Create New Puzzle window when you get to the page where you would otherwise choose a grid pattern.

A window pops up where you enter the theme words you want to fit (unlike making a vocabulary puzzle ALL of

the the words you supply will be used; if no grid can fit all the words the fill will fail). There are two option boxes

you can check:

Place symmetrically forces the theme words to be placed so that their arrangement is consistent
with standard 'S'-symmetry of the grid

Place in order fits the words in the across direction only, such that the words are placed in the
order given. This is useful for example for using a multi-word phrase.

Use longest word slots will ensure that the longest theme words fill all longest word slots in the
grid, with no longer word slots left empty.

When you have entered your theme words press the OK button. The program will then scan all grid patterns
available at the grid size you have chosen and filter the list of grid patterns so that only those that can fit the
words are shown. Click on a grid pattern to see the words placed in that grid.

There may be more than one way to fit the words into a given grid. Press the arrow buttons at the top right of

the grid preview to see the next (or previous) possible fill arrangement. Click New random fit to randomly

place the words in a different possible arrangement. To check whether it is possible to fill around the theme

words with words from your default word list press Fill around. If the fill succeeds you will be shown the

corresponding fill as usual with the option to accept it. If the fill fails you are returned to the Create New Puzzle

window so that you can try a different grid or word arrangement.

Instead of directly entering the theme words you can also use the Filter button to select specific combinations

of word lengths that you require. If you increase the Min count number, it will only show grids that have at

least that many word slots of that length. To avoid words of a particular length, you can tick the checkbox but

leave Min count at zero. If the No longer box is checked, the longest word length that you are filtering on will

be the longest-length slot available in the grid (with no longer empty slots).

https://www.crossword-compiler.com/ordering.html
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The Clue Editor

To edit the clue for a particular word in a puzzle press Ctrl+E with the cursor on the word for the clue you want

to edit. You can also click on the Edit button ( ) on the Toolbar.

If there are two words through the letter at the cursor, it will select the word in the current typing direction

(press Tab to change the type direction). You can only write clues for a complete word, i.e. one terminated by a

block, bar, or the edge of the grid. If you create a freeform puzzle by typing in words without blocks or bars use

Remove Blanks on the Grid menu before writing clues.

Once you have finished writing the clue click OK to close the dialog box, or click on the arrow button to edit the

next clue. The clue number is displayed in the title bar of the dialog box and the clue word is displayed below

that. There is a large input box for entering the clue and input lines for entering the format and an

explanation/citation/URL for the clue.

If the punctuation in the clue word is wrong you, left-click anywhere in the word and correct it. Right-click on

the word for options to change the case or capitalize. You can also change the solution independently of the

word in the grid; if the solution word is a material mismatch against the word in the grid it will be shown in red

to alert you. To edit the clue number text, for example to mark a clue as being special in some way, click on the

number above the clue and edit.

For cryptic puzzles, use Explanation/citation/URL to explain the clue's wordplay--for example, '2 defs'. For

non-cryptic puzzles, use Explanation/citation/URL as necessary to tell someone else (an editor, perhaps)

where to verify either an unusual answer or its definition. You can also use a URL, for example for a web page

that contains the information needed to solve the clue. Hint URLs can be clicked-on in the interactive solving

applet to help the solver with a clue. Rather than typing in the URL you can also drag and drop from the top left

icon of an Internet Explorer window onto the Explanation/citation/URL edit box. You can double-click on the

edit box to test-open the URL in your web browser.

The Database box at the bottom of the window lists any clues in the current clue database that you can use.

Press the Use clue button to use an existing clue. You can change the database to look in by selecting a

different database from the Look in drop-down box. If you want to look up a different word you can type it in

the Lookup box and press Go. (This can be useful; for example, if the word you are writing a clue for is plural

but the singular form has entries in the database which you may be able to adapt). Right-click on the list of

database clues to add, edit or delete a clue in the database. There is also a right-click option to change which

database columns are shown, e.g. if you wish to see the citation instead of, or as well as, the clue date.

Clues can be tagged to indicate if the word is a theme word, and add custom tags. For example, you might

want to tag all clues of a particular type (e.g. anagrams). Click the tag icon on the far right below the toolbar to

set or edit tags. In the pop-up Tags window you can check the Theme entry box if it is a theme word; this will

also show the word in the grid and Review/Edit Clues with a distinctive color (set in preferences, Display) to

that you can easily identify the theme words. To enter a custom tag, enter it in the Tags box, or select a tag

from the drop-down list of tags that you have used before. After closing the tags pop-up window, any custom

tags will the displayed to the left of the tag icon in the Clue Editor. You can see the count of words with different

clue tags in the Statistics window's Words page.
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Here's a summary of the clue editor commands. You can also call most of them by clicking with the mouse on

the buttons at the top of the dialog box:

Enter Close editor, saving changes

 ESC Close editor without saving changes

 Ctrl+V Paste text, including bold/italic and other formatting

 Ctrl+Shift+V Paste text without formatting

Alt+> or Ctrl+N Move to next clue, saving changes

Alt+< or Ctrl+P Move to previous clue, saving changes

Ctrl+D Delete the clue

Ctrl+K Link the clue

Ctrl+A Find Anagrams

Ctrl+F Find Word

 Alt+U Use the clue found in the Clue Database

Ctrl+L Display list of Letter Indicators

Ctrl+G Display list of Anagram Indicators

 F1 Bring up this help screen

Ctrl+W Show WordWeb Pro (if you have it)

There may also be buttons for looking up the word in third-party dictionaries.

You are advised to finish designing and putting words in the grid before starting to write clues. You can then

systematically write each clue in order so there's no chance of missing a clue or writing a clue for a word that

you will change later. Once you have finished you can review the clues by selecting Review/Edit Clues from

the Clue menu. Alternatively you can write the clues quickly using Review/Edit Clues as long as you don't

want to use any of the advanced features of the clue editor.

If a word is changed in the grid after its clue is written, the clue is deleted and moved to a temporary holding

area. If the word is restored to the grid during the same editing session (even to another slot in the grid!), the

clue is restored as well.

Editing the Clue

To edit the clue, or write a new one, simply type the clue in the Clue editor box. You can use bold, italic and

underline in a clue by pressing respectively Ctrl+B, Ctrl+I and Ctrl+U, or using the buttons on the toolbar.

You can also insert various special symbols into the clue by right-clicking, selecting the Insert Symbol option.

Just select the symbol you want inserted. To insert a character that is not on your keyboard select the Insert
Character option from the right-click menu.

You can change the format of the solution by entering the format in the Word Format input line.

If you click on the Anagram button or one of the dictionary buttons the current clue word will be

anagrammatized or looked up in the dictionary. You can also select any portion of the clue word, or part of the

clue, and then click on the button. This will then use the selected text instead.
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Editing order

You can change the order in which you edit clues in the global preferences dialog box.
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Reviewing and Editing clues

You can view and edit clues by clicking on the toolbar button ( ), selecting Review Clues... from the Clue
menu, or by using the keyboard shortcut Ctrl+R. The clues are shown in a scrollable list, with the clue number

at the left, and the solution to the right. The window can be left open as you work on the puzzle and will

automatically update as you change the grid or clues.

For more powerful editing features, including clue database lookup, double-click on a clue and the Clue Editor

will appear.

If there are incomplete words in the puzzle the solution appears with question marks for the missing letters

(you can only edit clues for complete words). If a solution word is shown in red it indicates a material difference

between the word in the grid and the word being clued.

You can spell-check the clues by pressing F7 or clicking the tick button on the toolbar. For each word that the

spell-check finds you can type in a replacement, ignore it or add it to the word list. Set the word list to use for

spell checking in the List Usage box, which you can view by clicking the Options... button on the spell-check

window.

Hold the mouse over the solution word to pop up a hint showing any explanation/citation/URL for that clue. If

the clue has a URL hint the number will be underlined - you can click on it to test-open the URL. Double click

to open the Clue Editor to edit the explanation/citation/URL.

It is a good idea to review the clues before you Print them to check you haven't missed any clues, or that any

words are incomplete. It also makes a convenient way quickly to edit the clues if you don't need all the

features of the clue editor.

You can resize the Review Clues window to better fit your screen by dragging the bottom right-hand corner

with the mouse. It will remember the size you set.

Right click on an answer word for options for changing the capitalization. To show all the answers in upper

case select the setting under Options.

The Review Options settings icon on the right of the Review/Edit clues toolbar allows you to customize what

is shown. If you wish to Show clue explanations/citation below each solution word, you can choose to show

them only When set, or Always (so, for example, you can easily enter new explanations/citations in the review

window rather than having to open Edit Clue). The color can be changed to clearly distinguish them from the

solution words.

The layout and formatting of the clues and answers is determined by the settings for the current grid, in

particular your Clue Properties settings (which you can change by clicking the properties icon on the

Review/Edit Clues toolbar). Review Options can be used to specify some specific fixed settings for the

Review/Edit window if you prefer: a fixed wide vertical clue spacing, and/or you can change the Font size
(e.g. to make it larger for easier viewing).
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Word Format - Automatic word length

Do not include the length, or format, of the clue in the clue editor, but in the Word Format input line. By

default, this is just the number of letters in the word, which is entered automatically. However, if the 'word' is

hyphenated, or more than one word, you can enter the format here. Just type the number of letters in each

word, or hyphenated half word, and a comma to indicate a new word or a hyphen to indicate a hyphen. The

format is then automatically included in brackets at the end of the clue you print it. The word is also correctly

formatted in the dialog box and when you print the answers.

You can also change the format simply by correcting the punctuation in the word given at the top of the clue

editor window. You can also change the capitalization, and use the right-click menu to change to lower case,

upper case or initial caps.

For example if the word is displayed as “ontopoftheworld” (On top of the world), then type '2,3,2,3,5' in the

format line. If the clue is linked then enter the format for the linked solution.

You can select to either add the format to the end of the clue or not by selecting the Print solution lengths in

the clue properties dialog box. Most British cryptics do have the format, most American non-cryptics do not.
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Clue Properties

Select Clue Properties... from the Clue menu to change the way in which the clues are arranged and printed.

There are three pages of settings, Format, which has general settings, Language specifics, which is useful if

you want to create non-English crosswords, and Printout, where you can change how the clues are spaced

on the page when you print them.

Select the Font... button at the bottom of the dialog to specify the font used for the clues.

Spacings

The Number-clue space is the distance between the clue number and the clue itself. The Between clues
space is the vertical separation between clues. A separation of zero will have the effect that the space

between clue lines is the same as the space between clues.

Number format

Check the boxes here to specify how you want the clue numbers to appear.

Clue Headings

The Across and Down boxes contain the text which will head the across and down clues. You might want to

change these so that they are in capital letters, or to translate them to a different language. You can also

specify some option for how the heading is formatted.

Clue Numbering

This setting determines the method used for numbering the clues. Normal is the standard numbering scheme.

By first letter gives the clues sorted alphabetically by the starting letter of the clue word, with each clue

'numbered' by the starting letter. By position numbers the clues by row and column. If there is more than one

clue on a row or column the clues are placed next to each other on the same line. Random order sorts the

clues randomly, and gives each clue an alphabetical letter instead of a number. Random by direction is

similar to Random order, but keeps the clues in separate Across/Down groups.

Clue one letter words

In most American and British puzzles there are no one letter words. However, in other countries one-letter

words are often clued. Select this box if you want to write clues for one-letter words.

Solution lengths after clues

Check this box if you want to automatically add the word format in brackets at the end of the clue. Select Only
if compound if you don't want to show the format for single words, only for compounds and phrases. Note that

if selected, solution lengths only appear when printed or exporting.
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Language Specifics

Alphabet

List here the alphabet of whichever language you want to use. The setting is used for various Crossword

Compiler features, for instance for pangrammatic grid filling , clue numbering by first letter (above) and grid

side numbering.

Linked clue text

This text appears when a word for a given clue is linked to another word. For example if 1 across is linked to

10 across, the clue for 10 across would read 'See 1', or whatever text you use instead of 'See'. You can use

“%s” as a placeholder for the number being linked to. You can include different text for linking across and down

clues by separating the text by “|”.

E.g. use “See %sac|See %sdn” to show “See 1ac” in the above example.

Text for fill-in words

This is used for heading the words in the crossword when you print the words in the crossword by word length

for fill-in puzzles. Use %u as a placeholder for the number of letters in the word, and put brackets around any

letter that should only occur if there is more than one word of that word length. E.g. '%u letter word(s)'.

Single letter Across and Down

Select a letter that is used in clue linking to stand for across and down.

Printout

Change the clue spacings to effect how the clues are printed out. These spacings are used when printing any

crosswords that you create. You can use them every time you start the program by clicking the Save these
settings as default box. The spacings are given as a percentage of the total width, that is the width between

the left and right margins.
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Linking clues

It is possible that you have two or more words in the crossword for which you wish to write a combined clue.

For example, if somewhere in the puzzle there are the two words PREGNANT and PAUSE you may wish to

write one clue for the phrase 'PREGNANT PAUSE' rather than two separate clues. To do this use the Link

Clues dialog box.

You can show the Link Clues dialog box by selecting Link Clues... from the Clue menu, or by pressing the

Link Clues button in the Clue Editor. If you use the clue editor and the word you are clueing is already linked

you must first clear the current links before making a new set.

The Link Clues dialog box

The left-hand side list-box shows all the words in the crossword which aren't currently linked. Select the first

word in the phrase you want to link and press the > button. Then the next one, and so on. The words you are

linking are shown on the right, in the order you linked them. The linked word is displayed at the bottom of the

dialog box.

To change the order of a word in the linked phrase, select the word and click on the arrows are the right of the

dialog box to move it up or down

The linked word is shown using the format in the Word Format input-line. You can change this to correct the

punctuation of the linked phrase, or you can edit the Solution word directly.

The Clue number text entry is automatically set every time you add a word to the linked phrase. Once you

have the phrase linked as you want you can change this entry as you link. The clue number text is the text

used for the clue number when printing, e.g.

By default it might be

2/3/6/7D This is the clue

and you could change '2/3/5/7D' to '2,3,5 & 7 Down' to make it appear as

2,3,5 & 7 Down This is the clue

Once you are satisfied with all the setting you can close the dialog box, or, to set another set of links, press the

Set links and select new set button.

To delete a set of links, put the cursor on one of the linked words, bring up the clue editor and click the Link

Clues button ( ). You will be prompted to clear the link.
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Anagrams

You can search for multiple word anagrams of a given word, either from the Clue Editor or by choosing

Anagram... from the Words menu.

If you click the anagram button in the Clue Editor the word you are clueing (or any text that is highlighted) will

be selected automatically. If you choose Anagram... from the menu you can type in a word and press Enter or

click the Find button to start the search.

Partial Words: Click this tab to find all the words in the word list that can be made using only some of the

letters in the search word. The remaining letters are shown in brackets after each word.

Contained in: Click this tab to find words that the search word is contained in. For example if the clue word is

'remain', it will find 'cremation', which is 'remain' plus the letters in 'cot'. The remaining letters are shown in

brackets after each word. The words are sorted so that ones where the remaining letters form an anagram

(like 'cto' which anagrams to 'cot'), and the letters are in order (as the letters of 'remain' are in 'cremation'),

appear first.

The anagram feature finds all the multiple word anagrams of the given word up to a certain maximum number

of component words. You can specify the maximum number of words in the List Usage dialog box, along with

the word list that is used. If you choose a large number the search is slower, as there will be a lot of different

anagrams. Specifying a small number also makes it easier to find a suitable anagram in the list.

Anagrams are displayed as they are found. The words in multi-word anagrams are not sorted, but anagrams

are found in order of word length, so you should get all the straight anagrams before the multi-word ones.

Re-size and move the anagram window as you please by dragging the bottom right corner with the mouse.

You can abort the Search at any time by doing another search of pressing OK. The program adds anagrams to

the bottom of the list as it finds them. If there are a lot of possible anagrams they may not all be found, but you

should always get at least the first thousand or so. The finder will work in the background as you edit other

clues or whatever. To bring the window to the top just click on it. You can leave the anagram window open. It

will be reset with a new word whenever you click the anagram button in the clue editor.

If you select an anagram in the list and press the Copy button it will be copied into the Clue Editor if it is open,

or to the clipboard if not.

You can save all the anagrams or partial words to a text file by right-clicking on the list box, selecting Save to
file..., and typing in a file name.
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Anagram Indicators

Anagram indicators are used in cryptic crosswords to signal an anagram. To see a list of indicators, sorted by

first letter, press the data files icon (book symbol) in the Clue Editor. A menu will pop up, and you can paste an

indicator into the clue by selecting a menu item. You can customize the list if you like. See the Lookup Lists

topic for more information.
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Letter Indicators

Letter indicators are words used in cryptic crosswords to represent a certain letter, for example England

represents the letter E. To see a list of indicators press the data files icon (book symbol) in the Clue Editor. You

can customize the list if you like. See the Lookup Lists topic for more information.
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Clue Databases

Clue databases allow you to store clues from puzzles that you have written, or to store your flashes of

inspiration until the word comes up in a crossword. You can create, open, view, and edit clue databases by

selecting the Database manager item on the Clue menu.

You can make a freeform puzzle using the words and clues in a clue database using the Create Vocabulary

Puzzle feature.

Use the Use clues from database command on the Clue menu to automatically write clues for a crossword

using an existing clue database (note that no clue databases are supplied, you need to make your own). You

can select which database to use, and the program will insert clues for all matching words in the grid. Note that

you need to have designed the grid and filled in words before using this feature.

You can add clues from puzzles to a database using the Add puzzle clues to database command. You can

also add clues from a set of puzzle files using Add clues from files. Both these features have an option to

datestamp or tag the clues so that you know when they were most recently used.

When you edit a clue using the Clue Editor you can insert clues from the database. The default clue displayed

in the Clue Editor is determined by the Default Database Clue setting in the Preferences dialog box. It can

either be the most recently added clue, the oldest clue, or one chosen at random.

You can use the Word List Manager to create a word list from the head words in a clue database, by selecting

the option on the Convert menu.

The database used by default with a given crossword is saved with the crossword. To save your database

settings for future crosswords, save the current crossword as a template.

Crossword Compiler clue database files are in a special database format, and cannot be edited directly outside

the program (technically they are a sqlite table). You can however easily import and export to CSV (Comma

Separated Values) format, as used by many spreadsheet programs. See the Database manager's menu

button for import and export options.
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The Clue Database Manager

Select Database Manager... from the Clue menu to display create, edit, view and manage clue databases.

The database manager window can be left open as you work on other things.

Select a database from the Clue database drop down list. The words, clues and other information is then

visible in the table show below. You can edit entries in the table directly, or use the buttons at the bottom of the

window to add, delete and edit clues. To view clues for a specific word, use the Word filter box: the listed clues

will automatically update to show matching entries.

You can also filter the clues shown by the value other fields (e.g. clue date and citation): select a field name

from the Field drop-down box, type the text to search for in the follow edit box and press the Filter button. The

type of match to perform can be changed by using the drop-down select on the right-hand side of the Filter box

(Exact match, containing match, match word, etc).

To make a new database click the New Database button. To add a clue to the database select the Add button.

Type in the word you want to write a clue for, tab down to the clue box and type in the clue. You can also add

an explanation and a date stamp (and any custom fields you have defined). Press OK to save the clue, or click

New word & clue or New clue, same word to save the clue and enter another one.

Changes to the database are saved as soon as you make them.

Click the Menu button to drop down a menu of additional commands.

Add custom column to define a new field for the current database. For example, you may want to add

new fields to track publication information, reference source, etc.

Open/convert to open a database file that is not in your default clue database folder, or to convert a clue

database from other programs (in CSV, comma-separated text format). After selecting the file to import,

you will be given options about which columns to import, the file separator and language. CSV files can be

edited and saved by many programs, including Excel and other spreadsheet programs.

Export to export a comma-separated value (.csv) file that can be used by other programs (e.g. Excel).

You will be prompted for which columns you want to export.

Merge to merge clues from another database into the selected one.

Add clues from files to add all the clues from a set of files.

Change index setting to specify whether you want words differing only by accents/case to be indexed

together. The default Upper case, all accents equivalent setting would show, for example, clues for Cafe

and café together whenever either form is looked up. If you are using a language where accents are

treated as different letter, you can instead use Upper case, accents distinct.

Clean up database to optimize the database file size, delete duplicates or similar clues. You will be

prompted for which cleanup operations to perform.

Delete database to delete the selected database.
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Browse folder to open the folder containing the database files (e.g. if you want to manually backup or

copy them).

Change database folder if you have multiple collects of databases in different folders and want to switch,

or want to save databases in a custom location.
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Printing a puzzle

Select Print/PDF for Review... from the File menu to print or export the crossword, with options to include

solutions and answers in a way that's helpful for reviewing (rather than solving). A dialog box is displayed

showing the various print options. Check the checkboxes for what you want printed. If you want to print out the

grid and clues in a multi-column format for solvers to use, you can use the Print/Export Worksheet option

instead. If you want to submit a standard crossword for submission to a crossword editor, you can click the Set
for review button to quickly configure clues-with-answers options that are commonly used for submission.

Headers

This prints the headers you have selected in the Headers dialog box, with the relevant information about the

current puzzle inserted. You can select the Header A or Header B to choose which header to use if you have

multiple headers available.

Puzzle, solution and numbered solution

Self explanatory. The numbered solution has the solution letters and the grid numbers. Select Print on
separate page to print the solution after the puzzle and clues on a separate page.

Clues and clues with answers

You can choose to print just the clues, in which case they are printed in two columns, or you can print the clues

with answers — clue on the left and the solutions on the right (as when you review the clues). Extra formatting

options for printing clues can be set in the Clue Properties box.

Code grid, Code solution

These are only available if you have a coded grid (numbered by letter). These options print out a blank and

completed grid of letter-number relationships.

Headers on each page prints the headers at the top of every page printed, not just the first

Separate pages prints each item you have selected on a separate page

Use hashed blocks can be useful if you want to speed up printing on a dot matrix, or stop the paper getting

soggy on an InkJet.

Collate will collate the pages and is only available with some printers

Copies determines how many copies of each page are printed.

Printer Setup show the Print Setup dialog box.

If you try to print the clues before you have written any, the program will print out the clue numbers with a blank

space next to it. This is useful if you like to work to a hard copy when writing clues. You can then type in the

clues when you are satisfied with them.



92

Note that very large puzzles may not fit on A4 paper. You will be asked whether the square sizes should be

shrunk to make it fit if the puzzle doesn't fit. To change the margins choose the Page Setup... command from

the File menu. You can change the printer by clicking the Printer Setup button (or selecting Printer Setup... on

the File menu).

You can save your settings for printing by pressing the Save options button. The settings will be saved for the

next time you print out a puzzle.

Printing the puzzle uses all the settings set in the various property dialog boxes.

See Grid Properties, Font and Clue Properties for more information.
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Print/Export Worksheet

Select Print/Export Worksheet on the file menu to export the puzzle and clues to a PDF file, MS Word, or to

print directly. The output format is suitable for people to solve the puzzle. Use the Print/PDF for review feature

if instead you want to print out for submission to a crossword editor or for your own use.

Under Action you can select whether to Print, Export PDF or Use Ms Word. Press Print preview to see

what it will look like before printing or exporting.

To export to MS Word select Use MS Word and then press Open for editing.

There are various options. Select Clues to include the puzzle and clues, Fill-in words to include the puzzle

and the list of words, sorted by word length. You can change the number of Columns that the clues/words are

printed in. The grid will span as many columns as necessary. If you have a puzzle with lots of short clues you

will probably find that increasing the column count allow you to fit the puzzle on fewer pages. Select the wrap
text round grid option if you want to allow incomplete-width columns of clues by the side of the grid. If this

option is not selected only full width columns of clues will be allowed. Select the Clues below grid option if

you don’t want columns of clues beside the grid, only below the grid.

Check the Include main header A box to include a header at the top of the page. See the print headers topic

for how to change the header. By default, the header includes just the title for the puzzle, set under puzzle

information.

The puzzle and clues may span any number of pages at the default size (grid size set under Grid Properties,

clue font set under Clue Properties). Check the Try to fit on one page box to force the program to shrink the

grid and clue font size to try and make everything fit onto one page. This is not always possible, but it is quite

often possible to decrease the page count by one, giving a rather neater printout. If it fails to fit on one page or

the font size is too small it’s probably worth trying again with a larger number of columns. By default the grid is

printed at the square size set in Grid Properties if it will fit, but if you are wrapping clues around the grid, you

can Scale grid to fill columns to automatically scale the grid to span the width of all but one of the columns.
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Print headers

Select Headers... from the File menu to specify the headers to use when you Print a puzzle.

You can have left and right headers, and below that a header that goes right across the page. The left and

right headers are half a page wide, and useful if you want to have text at the left and right at the same distance

down the page.

If you wish you can have two different headers - you could then use a different header depending on what you

are printing out. Just uncheck the Both headers the same check box, and click on the Header A or Header B
tabs to edit the corresponding headers. You can then select which header you want to use when you Print the

puzzle.

Select justification and font styles within each header by using the buttons on the toolbar.

When you have finished editing the headers press OK to associate the headers with the current crossword.

Click the Save as default headers button to store your headers for use with all puzzles that don't specify their

own headers. If you want to use the default headers with a particular crossword just click the Set default
headers button. If you want to use non-default headers for some types of crossword then you can save your

puzzle (with its headers) as a templates for use when you create new puzzles.

You may customize headers to provide constant text (such as your name and address) or variable data (such

as puzzle details or date). To supply constant text, simply type that text in one of the header boxes. To supply

variable text, use one or more of these control codes each beginning with a '%'.

%T Puzzle title %A Puzzle author

%C Puzzle copyright %I Puzzle description

%D Day of the month %W Puzzle width

%M Month of the year %H Puzzle height

%Y Year (abbreviated. E.g. '95') %N Number of words in puzzle

%% The percent sign '%' %B Number of blocks and clue
squares

%P Puzzle's path and filename %F Puzzle's file name

%G Number of the page being
printed

 

You can also insert the control codes by clicking on the book icon at the far left of the toolbar. When the puzzle
is printed the control code is replaced with the text it represents, in the font and style that you have used for
the control code.

Some examples:

What you want the header be What you type

12 x 15 puzzle: Sample puzzle %W x %H puzzle: %T
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Antony Lewis 10/5/16 %A %D/%M/%Y

File Name: DEMOPUZ.CCW File Name:%F

The puzzle title, author, copyright and description are set in the puzzle information box. Codes are particularly
useful in conjunction with these settings as they allow you to set the headers only once, and then just change
the title, author, etc., every time you create a new puzzle.
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Printer Setup

Select Printer Setup... from the File menu to select and setup a printer for Printing. Select the printer you

want from the drop-down list. You can press the Properties... button to set other options for the printer

selected. You can also change the printer setup from the Print dialog box.
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Publishing

Once you have created a puzzle with Crossword Compiler you may wish to send it to a publisher, or to use it in

one of your own publishing programs.

If you have a Windows publisher program, or word processor, the easiest thing is to copy what you want to the

clipboard and then paste it into the publisher program. You can export puzzles in more formats and with more

options using the Export feature.

What you need to do when sending puzzles to a publisher will depend on whom the publisher is, and what

formats they can accept. Rich Text Format produced by the Export feature is generally good for clues, but

some publishers cannot use it for grids. For those that don't like Rich Text Format for grids your best bet is

probably Encapsulated Postscript (EPS) or (usually better) PDF. High resolution TIFF or PNG bitmaps may

also be good, especially for grids containing pictures.

See the Export topic for details of the formats available for exporting puzzles.
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Copying to the Clipboard

You can copy the puzzle, clues, solution or answers to the clipboard for use with other Windows programs.

Select Copy to Clipboard from the File menu, and select what you want copied from the submenu.

Clues and answers are copied Rich Text Format and plain text. Puzzles and solutions are copied as metafiles

and bitmaps (at screen resolution). Which format will be used depends on which program you paste the data

into. You can also copy to the clipboard using the Export... command on the File menu, which gives you more

control over what is copied.

For more information and to take control over the format see Exporting puzzles
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Exporting puzzles

Rich Text - PDF - Picture - Plain Text - File Formats

Select Export... from the File menu for a range of options for exporting puzzles to the clipboard or to a file for

use with other programs.

If you want to export to the web instead see Web Publishing, exporting interactive crosswords to a file, or

exporting a printable web page.

The left panel in the Export Puzzle window lists available export formats. Click on the format you want, and

then in the second panel select what you want to export (e.g. puzzle or solution).

The right panel will show an options available for your choice of export format. Select the settings you want

here and press the Copy to clipboard or Export file buttons as required (some formats cannot be copied to

the clipboard).

You can save any export format and settings for re-use in the future. To do this click the Save button (to

change the default name edit the text in the Save as box). You can then load the setting in future by selecting

the saved for,at name from the Load export drop-down box.

To save the current setting as the default when you open the Export window click the Save options as default
button. Click on the Grid properties button to adjust the grid properties or Clue properties to change the

layour of the clues.

At the top of the Export Puzzle window are two tabs. Click the Export Groups tab to export in multiple formats

at once. See the export groups topic for details.

Here is a summary of the different export formats:
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Rich Text Format (RTF)

This is probably the most useful format if you want to use your puzzles in other Windows programs. Most

Windows (and some Macintosh) word processors and DTP programs can read Rich Text Format, which gives

full formatting information for the text and can contain embedded pictures of the puzzle or solution.

If you don't want your clues on separate lines but would prefer them all in one paragraph then click the Clues
in one paragraph box. This will export in the form:

1 Clue one - 2 Clue two - 3 Clue three...

Change the number of Columns if you want the clues to wrap round a certain number of columns, with the

grid spanning as many columns as necessary. If you select the wrap clues round grid option a non-full width

column of clues is allowed beside the grid, otherwise only full-width columns of clues are allowed.

You can customize the clue font, space between clues and the space between the clue number and clue by

clicking on Clue Properties. If you include the puzzle or solution it will be embedded as a metafile picture, see

below.

If you find that the clues do not copy correctly then try increasing the Number/Clue space or not having the

clue numbers right aligned (see Clue Properties). This can happen because some programs do not support all

the features of Rich Text Format.
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PDF

This option exports a printable web-compatible page (or pages) containing the selected items. The format is

the same as when using the Print or Print/Export worksheet features. PDF files can be viewed on screen using

the widely used and freely available Acrobat Reader software.



102

Picture

You can export the puzzle or solution as an image in bitmap, JPEG, GIF, PNG or TIFF format. Alternatively

you can also export the grid as a scalable graphic using the options:

Metafile: This is a scalable Windows picture, and is probably best for most applications since it will resize

without loss of quality.

EPS (Encapsulated Postscript): This produces a scalable picture that can be printed to PostScript

printers. It can also include a preview image so that you can see it on screen. This format is commonly

used by professional publishers.

PDF: This produces a scalable picture that can be printed or viewed on screen using Acrobat Reader.

You can use the picture in many graphics, word-processing and DTP programs.

See the Exporting Pictures topic for more detailed information.
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Plain Text

Plain text can be used by virtually any program on any machine, and is the most portable way to export the

clues and answers. However, plain text does not contain any formatting information, so most of the formatting

options you have selected for the clues will be lost.

You can also export the solution as plain text. This is most inelegant, but useful as a very reliable way of

transferring grid information. Various Internet applications take in grids in this plain text format. The character

that is used to represent blocks can be set in the Block Character input line, and similarly for Void Character.
Change the Clue/Number characters to change the letters that are used to separate the clue number from

the clue. Select the Right align numbers option to insert a space before short clue numbers so that all the

clue numbers finish at the same character position. Select Clues with Answers to have the uppercase

answer word after the clue (separated by the Clue/Number characters).
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File Formats

You can export puzzles in various file formats for use with other crossword software. Only the XML format

supports all puzzle styles, the others are restricted to simple crossword puzzles.

XML puzzle

This is a flexible, portable and documented file format that supports all main puzzle types. See the XML

format topic for details.

Across Lite (puz)

Use this option to convert puzzles to Across format PUZ files. (tm)Across is a puzzle solving package

available on the Internet from www.litsoft.com.

The Restrict Solution option does not put the solution letters into the file, so the solution is absolutely

secure (useful for competition puzzles). The Scramble solution option merely encodes the letters, and

can be revealed using the code number given once you have converted the puzzle.

Maestro

Use this option to convert puzzles to Crossword Maestro format .CMO files. Crossword Maestro is a

solving program.

The Restrict Solution option doesn't include the solution letters in the file, so people can solve the puzzle

without being able to cheat. Select Cryptic crossword to make Crossword Maestro's clue solver work in

cryptic mode. Select Barred crossword to flag the puzzle as being barred.

Crossdown format

Crossdown is a solving and compiling program. Crossdown only supports a limited number of square grid

sizes.

ipuz format

ipuz is an open JSON puzzle format, used for example by some solving applets

https://www.litsoft.com/
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Publishing to the web

Use the web upload button on the toolbar ( ), or Publish to the web under Web export on the File menu to

upload puzzles directly to a hosted website. Crossword Compiler includes an account for hosting your puzzles

online. The first time you use the feature you will be prompted to choose a domain name, username and

password for your account. After uploading your puzzle will be available for anyone to see. In addition, the web

hosting service includes build-in support for applet Save and Submit buttons, so you can easily let solvers

save puzzles and submit their solutions for your later consideration. You can also have a home page indexing

all of your uploaded puzzles.

For an example of what you can do see the sample puzzles.

If instead you want to export files for hosting on your own website or elsewhere, use the Export to files option

on the Web export sub-menu. See the interactive crosswords topic if you want to do this.

When you select Publish to the Web the Export interactive puzzle window will show. Here you can choose

various options, for example what buttons you want to appear with the applet, the size and various formatting

options.

Answer submission/checking By default the applet has no submit button. Select the Mark option
if you'd like the solver to see a marked list of their answers when they press the Submit button. Select
Submit if you'd like to collect solution and other information from solvers. After uploading the puzzle to
the site you can customize exactly what information will be collected using the website administration
features.

Include
Most puzzles have Interactive clues, but you may wish to restrict solution information if you want to
prevent solvers from cheating. Including a Printable PDF link will upload a PDF file that solvers can
load and print to solve your puzzle offline. This uses your default settings from Print/Export Worksheet.

Buttons/Timer
Check boxes here to select which buttons you want to include with the applet. Note that including
Solution or Reveal buttons allows the solver to cheat.

Sizes
You can adjust these settings to change the cell size in pixels or the clue font size.

Click the Applet options button to change the detailed properties of the applet display.

When you are ready make sure you are online and click the Upload to web button. The program will then

connect to the website, upload your puzzle and open the web preview page. The first time you do this you will

be prompted to choose a domain name, username and password for your account. If you already have an

account on crossword.info you can enter your existing username and password (or click Reset password if

you forgot the password to go to the website to get a new one sent). After you have registered the first time

you can click the Web site admin button to see links to your public and admin website pages, change your

password, and to cancel your account.

Grid properties and Clue properties

https://crossword.info/sample/
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These buttons are included so you can easily change the grid and clue properties. Changes to these settings

will be reflected when you export the puzzle in other formats.
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Interactive web puzzles

Select Web export on the File menu, and then Export to files to export a puzzle to be solved interactively on

your own web page. After selecting the options you require press the Export web page button to choose a file

name and export the web page. If you want to upload the puzzle directly to the provided puzzle hosting site

use Web Publish instead.

Crossword Compiler comes with a little program, called a applet, that you can use on your web pages so that

people can solve puzzles interactively. They can type letters into the grid and click on squares to highlight the

corresponding clue. The default applet (using JavaScript/HTML5) will run on most desktop computers, iPad

and Android and other tablets and phones.

The program is supplied with a variety of templates: select one in the HTML template box. The HTML

templates give an outline for the web page together with various settings for the export options.

This export option produces a web page file and a puzzle file. These must be uploaded to the same folder on

your website, see the uploading web pages topic for details.

There are various options in the export interactive crossword window:

HTML Template

Change this setting to use different templates for the web page that is produced. See the HTML Templates

topic for how to create your own templates. Right-click on the drop-down box to delete a template, create a

copy of the template with a new name, or to make a template using the default export options rather than its

own set of options.

Interactive clues

Select this option to automatically show the corresponding clue when the solver clicks on a square in the grid,

or to highlight the correct slot in the grid when the solver clicks on a clue in the clue list. Select Text Clues if

you just want to have static clues.

Solution link

Include a link to GIF picture of the solution.

Numbered solution link

Include a link to a GIF picture of the numbered solution.

Solution information

Check this option to include solution information (for the solution, check and reveal buttons). If this options is

unchecked the puzzle file will not contain solution information, and will therefore be secure for a prize

crossword. You must check this option if you want the completion message to show only if the solution is

correct (see the Applet Properties topic).

Get solution
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Click this button to copy to the clipboard the solution for the current puzzle. This is the text that is returned by

the applet’s submit button, so click this button to see what a correct submission should look like.

Buttons

The applet can display various buttons giving the solver some extra options. Select which buttons you want to

be available. The Reveal button is a cheat button to show the answer to the current clue. Reveal Letter shows

just the currently selected letter and Solution shows the entire solution.. The Revert button makes the puzzle

revert to the state when it was last saved (usually completely blank). The Check button will delete any letters

the solver has put in the grid that are incorrect. The Submit button will submit the solver’s solution, and the

Save button will save the solver’s current progress.

The Submit button requires additional advanced work by the website manager: you must supply a web script

to handle the submission data. Set the script URL under Applet Options You can also use your own script to

process theSave action; by default (if the URL is left blank), the state is saved in a cookie on the user's

computer.

If you use the Reveal, Reveal Letter, Solution or Check buttons you need to include Solution information.

The buttons can be to the left or below the grid, and you can change the button captions. See Applet

Properties for details.

Square size

Change the size of each grid square in pixels. This also indirectly affects the width and height of the grid, so

ensure that the square size isn’t so big that the whole grid won’t be visible on the web page.

Clue font size

Change the size of the font used to display the interactive clues.

Applet options

Click this button to customize various aspects of the applet. See the Applet Properties topic for more

information. For advanced customization options see the applet parameters topic.

Save options in template

Click this button to save the export options to re-use every time you use the selected template. This allows you

to associate different sets of options with templates to simplify exporting web pages with different layouts.

Save options as default

Click this button to save the export options for use with all HTML templates that don’t have their own settings

saved.

HTML export options

Check the Clues in one paragraph box to put all the clues in one paragraph instead of each on a separate

line. If Include font info is selected the web page will use the font you have specified as the clue font under

clue properties. (note that this font may not be available when people view your web page). Select Small
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inter-clue space to have clues separated by just a line break rather than a paragraph. Select Monochrome
GIFs to use black and white pictures for the grid, which reduces the display time if your grid doesn’t contain

any colors.

Grid properties and Clue properties

These buttons are included so you can easily change the grid and clue properties. These settings are not

saved in the HTML template but in the puzzle template.

Clue hint URLs

Select this option to show hyperlinks after each clue that has a hint URL set (see the Clue Editor to set a URL

hint - the Explanation/citation/URL option). This allows solvers to click on the link to open a window containing

the URL, for example with information to help solve the clue.

Using the applet with JavaScript and Customizing with CSS

See under the Applet Parameters topic.
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Printable web page export

Select Web page export from the File menu, and then Printable static page to export a web page with

pictures for the grid. To export a web page with an interactively solvable grid use the interactive web export

feature.

Use Puzzle and clues in columns to include the clues and grid, with the clues in columns, wrapped around

the grid (change the Columns setting to use a different number of columns).

You can also include a link to the solution, have just the clues (in two columns) or just the grid.

Select Export as... and enter a name for the web page. The program will create PNG files with pictures of the

grid and put them in the same folder as the web page. Be sure to put the PNG files on your web server along

with the HTML file. The PNG file names will start with the same letters as the main web page's file name.

These must be uploaded to the same folder on your website, see the uploading web pages topic for details.

See the HTML Templates topic for how to create your own templates for the web page that is produced.

Export options

Check the Clues in one paragraph box to put all the clues in one paragraph instead of each on a separate

line. If Include font info is selected the web page will use the font you have specified as the clue font under

clue properties. (note that this font may not be available when people view your web page). Select Small
inter-clue space to have clues separated by just a line break rather than a paragraph. Select Monochrome
GIFs to use black and white pictures for the grid, which reduces the display time if your grid doesn’t contain

any colors.
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HTML Templates

Crossword Compiler can export interactive or printable web pages containing the grid and clues from the

current crossword. To do this it uses a template file that you can modify to change the look of the web page

that is produced. For instance, you may wish to change the background color and include a link to your home

page.

HTML templates are stored in your Crossword Compiler Templates folder and must have the .HTML extension.

You can edit the file with a text editor like Notepad, or you may be able to use a dedicated HTML editor if you

have one.

To generate the web page for a crossword the program replaces various placeholders in the template with the

corresponding content for the current crossword. For instance, <CCCLUES> will be replaced by the clues

(including Across/Down headers). See the Default template supplied for an example.

The general placeholder syntax is <CCxxxx> where xxxx must be in upper case. You can use the following

placeholders:

<CCTITLE> Puzzle Title (see puzzle information)

<CCCOPYRIGHT> Puzzle Copyright

<CCAUTHOR> Puzzle Author

<CCDESCRIPTION> Puzzle Description

<CCCLUES> All the clues

<CCGRIDCLUECOLUMNS> A table with the grid and clues in columns

<CCACROSSCLUES> Just the Across clues (with the Across header)

<CCDOWNCLUES> Just the Down clues (with the Down header)

<CCJAVAAPP> Insert JavaScript applet

<CCENDJAVAAPP> Insert the </APPLET> tag.

<CCPUZZLE> The puzzle grid, of the form <IMG SRC=....>

<CCSOLUTION> The puzzle solution, of the form <IMG
SRC=...>

<CCSOLUTIONURL> The file name of the solution grid (e.g.
"MyPuzzle.GIF")

<CCCODEGRID> Code grid for a coded puzzle

<CCCODESOLUTION> Code solution for a coded puzzle

<CCFILEROOT> The root name of the HTML file (e.g.
"MyPuzzle")

<CCDAY> The day

<CCMONTH> The month

<CCYEAR> The year



112

<CCFONT> The clue font, of the form <FONT FACE=....
SIZE=...>

<CCENDFONT> The end of the clue font, </FONT>

<CCJAVAAPPWIDTH> Width of the applet

<CCJAVAAPPHEIGHT> Height of the applet

<CCPDFURL> A link to a PDF file of the puzzle

There is also the general placeholder

<CCPROMPT This will be the prompt>

You can use any text instead of “This will be the prompt”. When exporting you will be shown a window asking

for the “This will be the prompt” text. When you enter this it will replace the entire <CCPROMPT xxx> item with

whatever text you enter. Use this to add additional custom items to the web page, maybe a grid serial number,

extra information, or whatever.

If you are exporting an interactive puzzle you should use <CCJAVAAPP>. This should be followed by whatever

text you want to appear if Java applets are not enabled when the web page is viewed. There must then be a

<CCENDJAVAAPP> tag.

The are also a set of conditional elements. These must occur in pairs, the syntax being of the form

<CCIFxxxx> stuff here </CCIFxxx>

The "stuff here" is only included in the web page if the xxxx is true. You can use the following conditional

elements

<CCIFTITLE> True if the puzzle has a title

<CCIFAUTHOR> True if the puzzle has an author

<CCIFCOPYRIGHT> True if the puzzle has a copyright

<CCIFDESCRIPTION> True if the puzzle has a description

<CCIFCLUES> True if clues were selected to be included

<CCIFJAVA> True if the template is invoked from interactive export

<CCIFPDF> True if PDF link included

<CCIFPUZZLE> True if the puzzle was selected to be included

<CCIFSOLUTION> True if the solution was selected to be included

<CCIFCODED> True if the grid numbering is by letter.

<CCIFHASACROSSDOWN> True if clue numbering is Normal or By Position.

.<CCIFBUTTONS> True if using Java export with buttons in the applet

<CCIFGRIDCLUECOLUMNS> True if include a table of grid and clues

You can also use the corresponding <CCIFNOxxx> elements to be included if the negative is true.

The <CCFONT> and <CCENDFONT> elements will be deleted if the Include font info option is not selected.
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You can create several templates if you like. Just put them all in the Crossword Compiler Templates folder and

select the template you want to use when you export a web page.
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Solving Applet Properties

Click the Applet options button in the Export interactive crossword window to customize the way the solving

applet works. There are five pages of options:

Display

Clue Layout

You can have the clues either to the left, right or below the grid.

Clue Font

Choose SanSerif or Times Roman. Exactly how the font will look will depend on which system the puzzle

is being solved on.

Button Layout

Select whether you want the buttons to be displayed to the left of the grid or centred underneath the grid

and clues.

Clue View

Set the Width (or height if the clue layout is set to Below grid) of the clue display. You should ensure that

the longest clue easily fits in the clue view window, and that the clue view width isn’t so large that it won’t

all be visible in the web page. Set the grid-clue gutter to determine the space between the grid and the

clues, and between the clue views. Measurements are in pixels.

Show bar separators in collocations

Select this option to put a thick line between squares where there is a space in the solution. For example if

a word was “top hat”, this option would put a thick line between the “p” and the “h”. You must have the

word formats set correctly for this to work, and the setting is ignored if the puzzle you are exporting

contains bars.

Numbers visible in grid

If this is selected the grid will be numbered as usual. If you have a large grid with a small square size the

numbers may be hard to read or look messy, in which case you can deselect this option to hide the

numbers. With interactive clues the numbers are redundant anyway since the user can find out

immediately which clue belongs to which word slot.

Always show alphabet

Select this option to show the alphabet beneath the puzzle so that solvers can enter a letter by clicking on

it with the mouse. This can be useful for foreign language puzzles as solvers may not have accented or

Cyrillic characters on their keyboard. Change the alphabet (the letters shown) under Clue Properties. If

you are exporting a coded puzzle the alphabet will always be shown regardless of this setting.
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Buttons

Button Captions

You can change the captions of the various buttons that the applet can show. This is useful if you want to

change the captions to another language. You may also wish to change the English captions. For

example, if you don’t implement the Save button, the Revert button may be better given the caption

“Clear”, or if you implement the Reveal Letter button maybe you want to change “Reveal” to “Reveal

Word”.

Graphical buttons

Check this box to use icons for the buttons. Otherwise, standard text buttons will be used.

Always use wide buttons

By default wide buttons are used only if one of the selected buttons has a long caption. Select this option

to always use wide buttons. (Wide buttons are 20 pixels wider).

Limit cheats

Select this option to limit the number of times people can use the Reveal Letter or Reveal Word buttons.

.

URLs

This page is only available when exporting to files.

Save URL (Advanced users only)

Leave this blank to save the state of the puzzle in a cookie (default HTML5 applet only). Alternatively give

the URL of the script to run when the Save button is clicked in the applet. The script will be passed a

string representing the letters in the grid, with hyphens for blank letters. This string can then be used as

the PROGRESS parameter for the applet to restore the solver’s progress. It is up to the script to manage

how the saving process actually works.

The URLs can contain the %PROGRESS% placeholder which will be replaced by the progress string, and

%TIME% as a placeholder for the solving time in seconds [Applicable only if the timer is shown].

Example: For a script called “saveme.cgi” at “https://www.crossword-compiler.com/cgi-bin” folder the Save

URL might be “https://www.crossword-compiler.com/cgi-bin/saveme.cgi?%PROGRESS%”.

The Save URL is stored in the HTML file in the Applet’s “SAVE” parameter. It can thus be generated

dynamically if required. Note that the Save URL may have to be on the same server as the .html file

otherwise you may get a security violation.

Submit URL (Advanced users only)

The URL of the script to invoke when the solver presses the submit button. As for the save button the

page is passed a string representation of the letters in the grid. The Submit URL is stored in the HTML file

in the Applet’s “SUBMIT” parameter.
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Select Use human-readable submit format if you would like the submit button to return text that is

readily readable as a list of words entered in the grid (the words are separated by + signs). Otherwise, it

uses a compact format which is just all the letters entered in the grid in the order left to right, top to

bottom.

The URL can contain the %SUBMIT% placeholder which will be replaced by the submission string, and

%TIME% which is replaced by the solving time in seconds [Applicable only if the timer is shown]. There is

also a %MARKED% placeholder; this is like %SUBMIT% except that the solution string is preceded by a

string of zeros and ones indicating the correctness of the solution words. Only use %MARKED% if you are

using human-readable submit format, and have included solution information.

The %CHARSET% placeholder is replaced with the character set of the submitted information. This is

either the character set of the grid font you selected when making the puzzle, or the charset specified by

the OUTPUTCHARSET applet parameter.

Codebase

This gives the location of the Crossword Compiler applet code files. If these are not in the same folder as

the .html file you need to change the codebase setting, otherwise it can be left blank. Note that the applet

files must be on the same server as the web page.

Colors

You can change the colors used in the applet. Be careful using custom colors since these may not be

available on the solver’s system. Check the Show wrong letters in box to show incorrect letters in a

different color as they are typed in [the puzzle must include solution information for this to work].

Actions

The applet can show a message or redirect to another web page when all the letters have been filled in

the grid. Select the Solution must be correct box if you want to do this only if the solution is actually

correct. (For this to work you must also select the Include solution information in file box in the Export

window.) If you want no action to take place then just leave the completion message or web page blank.

Show completion message

Select this option to make the message appear when the solver has filled in the last blank square of the

grid. It can contain several lines.

Go to web page

Select this option to redirect to a different web page when the puzzle is complete. Enter the full URL of the

page you want to redirect to. The URL can contain placeholders as described under URLs above.

Options at the bottom allow you to specify when the timer starts and if it can be paused, and an option
controlling grid navigation in the solving applet.

Title and Copyright

The title and copyright can be embedded in the applet so that they always show above and below the grid.

Enter the text here if you wish to do this.
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Scrolling

Puzzle grid sizes are determined by the square size you choose when you export an interactive puzzle. Some

large puzzles may be too big to conveniently fit on screen, so instead the grid can appear in a scroll-box so

that the solver only sees part of the grid at a time. Set the options on the Scrolling tab to fix a maximum size

that you want to have. If the grid is then too large to fit in that size, scrollbars will be used.

Applet Parameters

For advanced manual customization options for the applet see the applet parameters topic.
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Word Lists

Crossword Compiler word lists are collections of words that you can use for word finding, finding anagrams

and filling in grids. You can have many different word lists, and use different ones with different crosswords,

and easily change between them when you're looking for words.

There are also Theme Lists. These are fairly small collections of themed words that can be used for creating

vocabulary puzzles or as a theme when you fill the grid. Word lists are larger collections of words, can be of

any size, and also have a score (see below) associated with each word. The Word List topics in the help file

refer to these larger word lists.

The program comes supplied with two word lists, but there are many optional ones that you can also use. You

can also create your own using the Word List Manager.

Things aren't quite that simple however! Each word in the word list also has an associated score, which

Crossword Compiler uses to find good fits when grid filling. You probably don't need to worry too much about

the word scores, but you can change them if you like using the Word List Manager (as well as in various other

places).

Each word list has an associated letter mapping and punctuation setting that defines which characters are

equivalent (for example, usually lower case letters appear as upper case), and which are removed before

using in the grid. There is also an associated character set, which allows you to restrict a list to characters

used in a particular language.

Word lists are stored as files of the LST file type. However, you should never need to deal with the wordlist

files directly unless you wish to copy the file (for instance for a backup).
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Theme Lists

Theme lists are fairly small collections of themed words that can be used for creating vocabulary puzzles or as

a theme when you fill the grid. Theme lists are stored in a plain text format, and should not usually contain

more than a few thousand words at most. Crossword Compiler is supplied with a variety of theme lists that you

can use. You can also create your own using the vocabulary puzzle feature, or by converting a main Word List.

The main Word Lists are larger collections of words, can be of any size, and also have a score associated with

each word.

Theme Lists are stored in your Crossword Compiler Word Lists/Themes folder. They can be viewed and

edited in the Word List Manager.
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Word List Manager

You can use the Word List Manager to view, edit, change and create word lists and theme lists. To open the

manager select Word List Manager... from the Words menu.

On the left there are two tabs. Click the Theme lists tab to view and edit theme lists, the Main Word Lists tab

to edit the large main word lists.

Main Word Lists

The box on the left shows all the word lists that you have at the moment. Below that there is a panel which

gives information about the selected list. To change the list information just type in some new text and press

the Change Info button.

To view the words in a list just click on its name, and then press the View button at the bottom, click on one of

the starting letters, or type a search into the Word filter box. You can also select a score in the score drop-

down filter box to only see words of a particular score, or select ... to select a range of scores.

Click (or press F2) on a word to edit it or its score. You can also select multiple words by holding down Ctrl

while you click on them; the right-click menu then gives you an option to change or delete the selected words,

change all their scores, change the case, or add/remove the words from other lists.

You can create new lists, and delete word lists, by pressing the buttons at the bottom of the window. For more

advanced functions select one of the options from the Word List or Convert menus. For example, to rename

a word list select Rename list from the Word List menu.

A history of word list changes is maintained on your machine so that you can undo mistakes and revert to

previous versions of word lsits. See Undo/revert Changes on the Word List Manager's main menu to see or

restore previous versions, and change options (like disk space used) for the backup history.

The font used for displaying the words can be changed under Preferences.

See the following for more information:

Viewing and editing lists

Creating new lists

Adding and removing words

Merging word lists together

Adding plain text word lists

Change case and punctuation

Changing word list scores

Duplicating and filtering lists

Converting word lists

Equivalent letters and punctuation

Character sets

Theme lists
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If you click this tab the box on the left shows the available theme lists. Click on a list to view the words in the

list in the right-hand box. You can edit the words in the right-hand box as you wish.

Click Sort to sort the words in the list alphabetically. Press Remove Duplicates to make sure each word only

occurs once, or Change Case to change the capitalization of words.

Use the option on the Convert menu to promote a theme list to a main word list. The Word List menu has

items for renaming and deleting lists, or for copying and pasting words from the clipboard.
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Viewing and Editing lists

You can view and edit the contents of a word list using the Word List Manager. Select the list that you want to

view and edit, and click on the View button. Words in the list will now appear on the right-hand side, with their

corresponding scores.

You can search quickly for a word by typing it into the Word filter box. This will show all words starting with the

given letters. You can also enter a search pattern, or select a score from the drop-down score filter.

If it is a large word list, and you haven't entered a search, the words will only be displayed one starting letter at

a time. You can change which starting letter to view by clicking on the alphabet to the side.

To edit a word, just click on it with the mouse or press F2. You can also change the word's score. You can also

select multiple words (hold down Ctrl while clicking on them), and then use the right-click menu to change their

scores, copy or delete them, or add or remove from other word lists.

When you change to another word list or close the Word List Manager the word list will be updated to reflect

the changes that you've made.

When a word is selected you can use Shift plus the left/right cursor keys to quickly increment or decrement the

word’s score. You can also press Ctrl+C to copy a word to the clipboard, or Delete to delete it.

You can see various word list statistics, including the distribution of word lengths, letters, scores and formats,

by selecting Word list statistics from the Wordlist menu in the Word List Manager.
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Creating new word lists

To create a new word list, open the Word List Manager and click on the New... button. Enter a name for your

new word list and press Create. You can also select a character set for the new list, and specify its equivalent

letters (for how you want words in the list to be mapped into words shown in the grid).

Your new word list will now appear in the Available Word Lists box, and it will be empty. You can type in a

description of the list below the list of word lists, and press the Change Info button to store it permanently. If

you want to fine-tune how punctuation is handled in the word list, use the equivalent letters and punctuation

setting.

When you've made the new list you can add words to it directly, or add words from another word list.
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Adding and removing words from word lists

To add or remove words from any of the existing word lists, first open the Word List Manager and select the list

that you want to change.

Adding words

Either press the Add... button or select Add Words form the Word List menu. After you've typed in a word

press Enter, and it will appear in the box below with the score specified in the Score number box. Keep typing

in words, pressing enter after each one, until you've typed in all the words you want to add, and then press the

Add All button, which will add them to the word list. If you want to add the words to more than one list, you can

Ctrl+Click to select multiple lists to add to.

If you make a mistake you can change the word by double-clicking on it, correcting it, and pressing Enter.

You can also quickly copy and paste in a batch of words, just select a list of words in some other program (one

word per line) and click the Paste batch button. They will be appended to the list of words to be added all with

the score currently set in the score box. If the words have the wrong score, you can change them all using the

Change Scores button before adding to the list(s).

Removing words

Select Remove words... from the Word List menu and just type in the words you want to remove. Press

Enter after each word to start a new line. When you've finished either press Alt+O or press the OK button. The

words will then be removed from the selected word list. You can also Ctrl+Click on several word list names to

remove from multiple word lists at once.

If you come across a word that you want to remove when using AutoFind or Find Word, just select the word in

the dialog box and press delete. You can also delete a word in a crossword grid by placing the cursor in the

word, changing its direction to the direction of the word (by pressing TAB), and pressing Ctrl+D.

Finding, adding, removing and editing specific words

You can use the filter boxes in the Word List Manager to see words matching a particular pattern or with a

particular score. By right-clicking on the word(s) there are options to delete and modify the words, add or

remove then from other word lists, adjust the score, or copy to the clipboard. You can select multiple words by

holding down the Ctrl key while clicking on the ones you want to select.
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Adding plain text and theme word lists

It's possible to add plain text word lists to Crossword Compiler lists using the Word List Manager. If you are

converting a plain text word list it must have the same format as the theme lists, i.e. it must have one word per

line like this:

First

Second

Third

Punctuation, capitalization and word order are not important. To add the list open the Word List Manager and

select the word list to which you want to add it. Then select Add theme list/text file... from the Word List
menu, and select the file that you want to add. You will then be prompted for what scores you want to give the

added words.
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Merging and removing word lists

You can add other word lists to a word list and remove the words in one list from another list using the Word

List Manager.

Adding other word lists

First select the list that you want to add the other lists to, then select Add other lists... from the Word List
menu. Select the word lists that you want to add and change the score settings as desired. When you press

the OK button the lists will be added, and you'll be shown a summary of the changes that have been made.

You can also right-click on a word list and select All list to other lists to merge that list's words into one or

more other word lists.

Removing words from another list

Select the list that you want to remove words from. Then select Remove words from... from the Word List
menu and select the list(s) whose words you want to remove. When you press OK the words will be removed,

and you'll be shown a summary of the changes made.

If you want to modify a list but keep a copy of the original you can use the Duplicate list command on the

Word List menu, which creates a copy of a word list with a name you specify.

You can also right-click on a word list and select Remove list from other lists to remove that list's words from

one or more other word lists.

Select the equivalent words option if you want the action to be applied irrespective of case or punctuation

(according to the list's letter mapping and punctuation setting).
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Word scoring in word lists

Each word in a Crossword Compiler word list has an associated score. The value of the score can be anything

between 0 and 100. The scores are used to optimize grid filling, and to allow you to cut off words with too low a

score when you're finding words or looking for anagrams.

You can view the distribution of scores in a word list (along with other statistics) by selecting the word list, and

then Word list statistics from right-click menu.

For example, in the default word list most words either have a score of 25 or 50. The words with 50 are rather

more common, and are generally root words (i.e. not many -ing, -ed, endings, etc.). When you do grid filling,

Crossword Compiler can use this information to make sure that you get far more of the better words in your

crosswords. You could also hide all the words with a score of only 25 by setting the cut-off minimum score for

word finding, anagram finding or grid filling to, say, 30. You can change the cut-off scores in the List Usage

box.

The absolute magnitude of the word scores is not very important. Mostly what matters is the relative scores,

with a word higher than another being used much more frequently (in grid filling).

In detail, the scoring of the default English word list is as follows:

Fairly common words
50

Less common words and word derivatives
25

Vulgar words likely to be unsuitable for crosswords
10

The low scores contain words that are not well known in the version of English you selected when you installed

the program:

Fairly common words from other English varieties
3

Less common words from other English varieties
2

Hence the default cut-off score of 5 will avoid all words that aren't used in your preferred variety of English. If

you installed for American English, these would include Briticisms, Canadianisms, etc.

See the Change Scores topic for how to view and edit word scores.
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Changing word list scores

Each of the words in a word list has an associated score. You can change the score of individual words by

viewing and editing words directly, or change all the scores in a list by selecting Change scores... from the

Word List Manager's Word List menu.

To change the scores in a word list, open the Word List Manager and select the word list whose scores you

want to change. Then select Change scores from the Word List menu. You can either change all the scores

to a certain value, or change all the scores by a certain amount (which is usually what you want as it preserves

the score ordering), or change scores of a certain value to another value.

Scores of words used in a puzzle can be adjusted (e.g. to reduce the score so that they are not reused often in

subsequent fills), using Change scores of words in puzzle. Scores of each word in multiple lists can be viewed

and adjusted using View/Edit words and scores on the Words menu.

During grid filling, scores can be edited in the Words Used list (button on toolbar) when you have a complete

fill, or by right-clicking on a word during Manual word selection or using AutoFind.
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Character sets

Crossword Compiler can be used in many languages, and supports the full unicode character set (with some

minor restrictions).

Each Crossword Compiler word list has an associated character set, which can either by Unicode if it supports

all characters, or a specific reduced character set (e.g. Western, Greek or Cyrillic). In most cases it makes little

difference which you use. Using Unicode has the advantage of supporting anything in any language. Using a

reduced set may be helpful if you want to avoid words containing words in foreign character sets (e.g. when

importing text word lists from multi-language sources).

You can change the character set associated with a word list in the Word List Manager. Select the word list

that you want to change, and then select Character Set... from the Word List menu. Then click on the set that

you want to use. If you check the Save as default box each new word list that you create will automatically

use the character set that you have selected.

Although the program supports the full Unicode character set, there are some restrictions: the Grid Filler can

only use 63 distinct characters at a time, which in practice means that for example you cannot use Chinese

words to fill a grid (there is however no problem using Chinese for clues or individual squares). It also only

supports single-entity Unicode characters, not extended characters made from extended combinations of

individual characters.
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Converting word lists

Crossword Compiler word lists are in a special format that cannot be used by other programs. However, it is

possible to convert to and from the Crossword Compiler format by using the commands on the Convert menu

of the Word List Manager.

Converting a word list to a theme list or plain text

Select the word list you want to convert in the Word List Manager and then select List to plain text file or List
to theme list from the Convert menu. Type in the name you want to save the converted file as and press

Save. If exporting to a file, you will be prompted whether to include scores, and if so, using what score

separator (theme lists do not have scores). In both cases words are saved one per line.

Converting plain text file to a word list

You can convert a plain text word list file containing one word per line (as for adding plain text word lists to

existing Crossword Compiler lists). Select Plain text file from the Word List Manager's Convert menu and

select the file that you want to convert. You will then be prompted for a name for the converted word list, and

what score you want to give its words. You can also select a character set for the new list, and specify its

equivalent letters (for how you want words in the list to be mapped into words shown in the grid).

You can also import scored word lists, where each line in the file has a word followed by a score. By default,

the score is separated by a semicolon, but you can also specify tab-separated or a custom separator. Usually

the separator will automatically be set for you.

Converting a theme list to a word list

To convert a theme list to a main word list, change to the Theme lists tab in the Word Lists Manager, select

the list you want to convert, then select Theme list to list on the Convert menu.

Converting words in a clue database to a word list

You may wish to use only words for which you have clues written, in which case it is useful to have a word list

containing only words for which there are clues in the clue database. Select Clue database words to list from

the Word List Manager's Convert menu.
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Crossword Glossary

Afrit's Law The injunction for Ximinean cryptic clues that
'you need not say what you mean, but you
must mean what you say'

Barred grid A grid in which thickened lines, as opposed to
blocks, mark the end of words

Crosswordese Words excavated from obscure dictionaries
that are only ever seen in crossword grids.

Cruciverbalism Crossword study or general wordsmithism

Light An entry in the grid - usually a word to be
clued

Pangrammatic Pertaining to grids which contain every letter
of the alphabet

Unch A letter in a light that does not intersect with
another light—an unchecked letter.

&Lit A cryptic clue where the entire clue is also a
'literal' definition of the light.

Ximinean Pertaining to a type of 'square dealing' cryptic
clue containing a definition and secondary
cryptic definition which can be decoded by an
exact interpretation of the grammar in the
clue.
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Introduction to Cryptic Crosswords

Cryptic clues are very popular in Britain, and have a following in North America. In cryptics, unlike 'quick' or

American crosswords, the clue has a cryptic part in addition to a definition part. This makes them harder to

solve, but there should be no ambiguity about whether an answer is correct or not. The cryptic part of the clue

consists of some instructions on how to put together the answer from its letters, a play on words, or some

other quirk. Here is an explanation of some of the more common clue types, though in practice many clues will

be a combination of these simple types:

Double Definition

Here the clue consists of two parts, both of which are synonyms or definitions of the word. E.g.

Calling charge (6)

=CAREER, calling (meaning job) and charge (as in to charge round) both mean career, though not in the

meaning first implied by the clue.

Likewise

Money-lust (3) = YEN

Cook fish (3) = FRY

Anagram

This consists of two parts, an anagram of the word and a definition. Often the anagram is indicated by some

Anagram Indicator, meaning 'mixed up', 'shuffled' or whatever. E.g.

Platter to cook waffle (7)

=PRATTLE, anagram of 'platter', meaning to waffle. 'To cook' indicates the anagram, though more properly 'to

cook' would be before the anagram. However, misplaced indicators, or completely omitted indicators, are quite

common.

Likewise

Rioted to get control of news! (6)

= EDITOR, an anagram of 'rioted'. The anagram indicator here is 'rioted', which is also the word to be

anagrammed, hence the exclamation mark that usually indicates some overlap in the clue.

Reversal clues are special cases of anagram clues, where the anagram happens to be just the word

backwards. In this case it would be indicated by some word such as 'back' or 'rising'.

Hidden Word

Here you can find the word in the middle of the clue. It is normally indicated by some word like 'inside'. E.g.

Uncover a veneer, inside is black (5)
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=RAVEN, meaning black. The word is hidden in 'UncoveR A VENeer' .

Homophone

This is where the cryptic part of the clue leads to a word that is pronounced the same as the answer but

spelled differently. It is usually indicated by some word or phrase like 'we hear' or 'reportedly'. E.g.

Heard the branch bend (3)

=BOW, meaning 'bend', a homophone of 'bough' (meaning 'branch'). These type of clues can turn into more of

a pun, where the clue is followed by a question mark:

Poem heard from soprano pigeon? (5)

=HAIKU, a Japanese poem, pronounced roughly as 'high-coo'.

Charade

The clue spells out the parts of the word. E.g.

Failed English dandy (4)

=DUDE, meaning dandy. Failed=DUD, English=E (this is a standard letter indicator for the letter E), hence

DUD+E=DUDE.

Often these have more than two parts.

Container

The clue instructs you to place some letters inside others, producing the word. E.g.

Complain when club admits the French (5)

=BLEAT, meaning complain. Club=BAT, the French=LE (using foreign words like this is another standard trick),

admit 'LE' to the middle of 'BAT' and you get 'BLEAT'.

? clues

The '?' is used to indicate some pun or weirdness in the clue. It can be used on almost any clue that doesn't

follow the usual forms of clue. E.g.

Meeting needed to make pear juice? (5,10)

=PRESS CONFERENCE, you need to press conference pears in order to make pear juice.

Park? (6,4)

=COMMON NOUN, 'park' can mean a common, and is also a common noun.

It is used in 'backwards clues', where the answer to the clue could be a clue itself, e.g.

Wot, wot ?(3,4)

= TWO FOLD, if you take 'two' and 'fold' it you get 'wot' . 'Wot' occurs two-fold in the clue. Likewise
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Draw? (8)

=BACKWARD, 'draw' ='ward' back(wards). These clues do not have a definition part. This is usually only

acceptable if the clue has some other particular merit.

'!' clues

Like the '?', the exclamation mark is sometimes used to indicate something unusual. However usually it

indicates some overlap in the clue, where say the word to be anagrammed also forms part of the definition. An

example is

It's in hearing! (3)

=EAR, 'ear' occurs in 'hEARing' and if you are in hearing your ear certainly is!

or how about

Damn! (9,4)

=CROSSWORD CLUE (it's a cross-word clue!).

The exclamation mark is also used very occasionally in ultra-short clues, e.g.

L! (4,3) = TAIL END or J!(4,5) = JUMP START

The clues lack any definition part, and the '!' could equally well be replaced by a question mark. Clues without

any definition are frowned upon my some crossworders.

Indirect Anagram

These clues are like anagram clues except that the anagram is not given explicitly and must be deduced from

a synonym or whatever. This type of clue is very difficult unless the word is very short, and is frowned upon in

many circles. E.g.

Find hole in tangled string (4)

=PORE, meaning 'hole', an anagram of 'rope' which is itself a synonym of 'string'

Must go round garden (4)

=NEED, anagram of 'EDEN', a garden.

Others

There are numerous other varieties of clue, most of which are used in special crosswords where the solver is

told about the type of clue used. For example in misprint clues, where a part of the clue has been misspelled,

the misspelling must be corrected before the clue can be solved. E.g. the definition part of the clue may be

'harp', but it would appear in the clue as 'hard'. This makes everything much trickier!

Further reading

See the bibliography
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Bibliography and further reading

There are many good books on solving crosswords, some books that may be of interest to compilers are listed

along with a general list of crossword-related links is available at www.crossword-puzzles.co.uk.

https://www.crossword-puzzles.co.uk/
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Customer support and upgrades

As well as this help file, a number of help documents and videos are available online, see them on the tutorials

page.

Contacts for customer support:

E-Mail : https://www.crossword-compiler.com/contact.html.

The Crossword Compiler users' page on the Internet at https://www.crossword-compiler.com/users.html. Minor

upgrades are also available for download on the same page.

https://www.crossword-compiler.com/tutorials.html
https://www.crossword-compiler.com/contact.html
https://www.crossword-compiler.com/users.html
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Equivalent letters and punctuation in word lists

Each word list has an associated letter mapping that defines which letters are equivalent. For example, in most

puzzles upper case and lower case letters are treated as equivalent. In many countries accented letters are

also equivalent to the unaccented letters for the purpose of intersecting words in crosswords. Thus if é is
defined as equivalent to E, any word containing the letter é will appear in the grid with E substituted for é.

Use the Equivalent letters option on the Word List Manager’s Word List menu to define which letters in a

word list are equivalent. You can also choose the appropriate mapping whenever you make a new word list.

Each line in the letter mapping is of the form A=B, or ABC=D, where you want the latter A to be mapped to B,

or all the letters ABC to be mapped to D.

Click the Set all accents equivalent to map all accented letters to their unaccented forms. Click Map all
letters to upper case if you just want to map letters to their uppercase equivalents. If the box is black, all

letters will be distinct, so grid fills will be case-sensitive.

The Punctuation tab can be used to fine-tune which non-letter characters are removed from words before

inserting in the grid. Spaces are always removed, but here you can select which other characters to ignore.

Unless you want to use some punctuation symbols for special purposes, you can probably use the All
punctuation option.

The characters that are allowed in the list depends on the word list's character set.
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WordWeb

WordWeb is an English thesaurus/dictionary add-on for Crossword Compiler. Once you have it installed you

can use it from the Clue Editor to look up selected words, or from the Words menu. To look up a word (or a

letter pattern) in the grid just press Ctrl+W. It can also be used to automatically format answer words correctly

(if this option is selected under Preferences).

For more information on using WordWeb select Help from the WordWeb window's menu.

Information about WordWeb is available on the Internet at https://www.crossword-compiler.com/wordweb.html.

https://www.crossword-compiler.com/wordweb.html
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AutoFind

Use AutoFind to find words to fit in the puzzle. Click the toolbar icon ( ), select AutoFind from the Words
menu, or click the right mouse button on a square in the word slot that you want to fill. Words are found to fit in

the current typing direction, but if there is only one possible word through the cursor's square, words are found

to fit in that direction.

For example if you had a puzzle that looked like this:

You may want to find a word to fit down the middle. Click with the right mouse button on one of the squares, for

example, above the 'D', to pop up a list of words that fit. Simply scroll through and select the word you want

and press Insert. When you select a word you can see it in the grid in grey. If you selected the word admiral
then the puzzle would look like this:

If AutoFind doesn't immediately come up with a suitable word you can search in any of the other word lists you

have set up by clicking on the tabs at the top of the AutoFind dialog box. The word list that is used by default,

and the word lists that are displayed, can be changed by selecting Change list usage... from the Words menu,

of the Settings icon button at the bottom of the AutoFind window.

To find words matching a certain pattern use the Find Word... command on the Words menu. To find a fit for

whole sections of the puzzle (rather than just one word at a time), use the AutoFill command on the Words
menu.

If you want to find words of various lengths that would fit in the grid you can use Shift+Alt+A, or Ctrl+Right

Mouse to bring up the Find Word dialog box set with the word pattern at the current cursor position.

AutoFind can also show only words which, when inserted into the grid, will not cause impossible letter

combinations. To show only words compatible with their intersecting words, click the button in the bottom-left

corner of the AutoFind box. The word that is compatible with the most intersecting words in the default word

list will be selected. You can show only compatible words by default by changing the setting under Change list

usage. To show all the words that will fit regardless of the intersecting word slots just press the button again.

If your search comes up with a word that you want to remove from the word list just select the word and press

Delete. It will be removed form the word list in which it was found. Alternatively you can right-click on any word

to edit it, change the score, delete it, or add to and remove from specific word lists.
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You can also use AutoFind on a complete word in the grid. If the word is not in the selected word list there is

an option to add it.

The font used for displaying the words can be changed under Preferences.

AutoFind (any length)

Select this option from the Words menu, or press Shift+Ctrl+A to find words that will fit in the current word slot,

including words not long enough to fill the entire slot. Select a word and click the Insert button to paste a word

into the grid. A block (or bar) will be inserted at the end of the word if it is not long enough to fill the entire word

slot.
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Using AutoFill to fill a crossword

You can fill in complete puzzles, or sections of puzzles from a word list using the AutoFill command on the

Words menu. You can also click on the AutoFill icon ( ) in the Toolbar or press Ctrl+A.

AutoFill fills in the grids with the default settings in the Fill Grid dialog box.

For more information about grid filling see Filling words in a crossword grid .
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Advanced puzzles types and how to make them

This topic describes how to change the grid, square and clue properties to achieve various different effects in

your puzzles. See the topics Standard Crosswords, Vocabulary/Freeform puzzles, Shape Puzzles, French

Style Crosswords, Barred Crosswords and Clues in Squares puzzles for the standard puzzle types.

Skeleton puzzles and hint-
letters

To make the 'R' visible select

the square and open Square

Properties. Select the Letter
visible in puzzle box. By

selecting all the rest of the

squares except the one

numbered '5', selecting square

properties, and clicking on

Blank in puzzle you can make

any evidence of the other

squares disappear.

Colored squares, letters and
lines

Change the color of grid lines

and block colors under Grid

Properties. Use Square

Properties to set the colors of

individual squares. Set the color

of letters and numbers by

changing the grid font.
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Clue Types

Un-numbered clues

A Some (3)

B Greek harp (4)

C Burden (4)

D Vase (3)

E Utilize (3)

F Aged (3)

 

 

Clues are displayed in random

order, each is assigned a letter

in order of listing.

Set Clue Properties Clue
Numbering is to Random
order.

Fill-in words

3 letter words
 ANY

 OLD

 URN

 USE

4 letter words
LYRE

ONUS

 

In these puzzles there are no

clues and the idea is to try and

fit the words into the grid. Just

create any type of puzzle and

then print out or export Fill-in

words.

The grids for this type of puzzle

usually would have Square
Numbering set to None under

Grid Properties.
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Preferences

You can customize various aspects of how Crossword Compiler behaves by selecting Preferences... from the

Options menu. To change how the program looks (dark or light themes), select Dark/light theme from the

Options menu instead.

Under Preferences, there are five pages of settings that you can change. The settings are global to all your

crosswords, and you can save the settings as the default for each time you run Crossword Compiler by

clicking the Save as default box at the bottom of the window.

Options

Opening and Saving

Select Create backup files to save the old file with a .BAK extension each time you save a file. The

Auto-save recovery files option will allow Windows restarts (e.g. for updates) without prompting to save

opened files (automatically re-opening them when the program is next opened), and generate autoload

recovery files in the case of a crash. You can customize how frequently the recovery files are saved.

Select the Show information on open option to show the Information dialog box whenever you open an

existing crossword.

AutoFind on complete word

This setting determines what AutoFind will do when invoked on a complete word. Select See if word is in
list to just spell check the word—the word either will or won't be in the word list, and either will or won't be

displayed. Select Find alternative words that would fit to find all the other words that could replace the

word in the grid without affecting the letters that are part of intersecting words.

Display

Colors

The color settings in the scroll box allow you change colors that are used when editing or filling a grid.

Scroll down to see more settings, including the colors used for Grid Insight.

Font for displaying words in lists

Click the Change font… button to change the font that is used in the AutoFind, Find Word, Word List

Manager and various other windows whenever words from a word list are displayed. By default, this is a

fixed pitch font so that letters in words under each other are aligned. However, you can choose any font

you like. The fixed pitch fonts are usually Courier and FixedSys. A sample of the current font is shown to

the left of the font button. If you wish to use different character sets in your word lists you should ensure

that the font you choose supports the different character sets.

Clues/Answers

Editing order
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Using the Clue Editor you can either edit clues in the order of their clue numbers, or you can edit all the

across words first, then the down words.

Default database clue

This option determined which clue in the clue database is displayed in the clue editor when you edit a

clue. You can view the rest of the clues in the database by clicking on the down button at the side of the

Database entry.

Show upper case

Select any outputs that you always want to be in upper case.. If you answers words in in upper case for

review, Review/Edit Clues or print Clues with Answers.

will use upper case, but not when answers are exported directly unless you also select the "for export"
option.

Changing grid does not delete clues

If this option is selected you can edit a word slot in the grid and any clue for the word slot remains

unchanged. Otherwise, when you change the word in the grid the clue is moved to a temporary holding

area, and deleted for the current word slot.

Prefer solution format in database

When you use a clue from a clue database when this option is selected the solution word formatting is

taken from the database. Otherwise the formatting is left as it is. Deselect this option if you have a

database without correctly formatted solution head words.

Format insensitive database clue sorting

By default this option is unselected, and clues in a clue database that have an exact match to the solution

word in the Clue Editor are shown first. Select this option if you would like to sort clues by date (see

above) irrespective of whether the solutions have the same case and punctuation as the word in the Clue

Editor.

Use WordWeb for automatic clue formatting

This option is available if you have WordWeb installed. If selected it will automatically use the WordWeb

database to correctly punctuate words that are being clued.

Always update (WordWeb)

Use this option to always change the lookup word in the WordWeb window whenever the word in the clue

editor is changed. Otherwise, the lookup word is only changed if the new word does not have a clue.

Clue text when there is no clue

This text is printed when you print a clue before you've written it.

Custom Lookups

You can add files and delete files that are used for lookup lists by clicking the Add and Delete buttons.
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You can add a list of items (one per line) to be used in the Explanation/Citation/URL drop-down in the

Clue Editor for quick re-selection. If Add new entries from puzzles in session is checked the list will

also automatically grow to include all entries added during the current session (the list can be reverted to

the default using the right-click option on the entry box in the Clue Editor).

Dictionaries

The easiest way to access dictionaries is via WordWeb Pro, which has several Oxford and Chambers

add-on dictionaries available. However, you can also link to other programs on your computer, or to

websites, adding an additional button to the Clue Editor.

Click the Auto-detect dictionaries button to scan for and install known dictionaries.

You can also add website look-ups, for example to look up a word on Google you might click on Add…
and enter “Google” as the name, and then type https://www.google.com/search?q=%s in the Exe
name/URL box.

If you use the auto-detect feature you can ignore the remained of this topic, which is advanced and

requires more than average computer know-how. You should only need to add dictionaries by hand if they

are not supported.

To add a dictionary select the Add... button, and type the name of the dictionary (this should generally be

the text that appears in the dictionary's window title when you run it). Type in the name of the application

file in the Exe name/URL input line, including the full path (e.g. C:\Chambers\Chambers'). If the program

has command line parameters include these here too. To include the name of a look-up word in a

command line parameter use the '%s' placeholder. E.g. for example Exe name/URL might be

c:\Program Files\Vendor\ProgramName.exe "%s".

If the file path contains spaces then enclose it in quotes, for example for RH Webster's Unabridged

Dictionary the Exe name might be

"C:\Program Files\Random House, Inc\Random House Webster's Unabridged
Dictionary\RHUD30.exe"

If the dictionary supports DDE (it should say so somewhere in its documentation) you can then enter text

in to the Service, Topic and Command input lines. The Command entry can contain the '%s' placeholder

to stand for the word being looked up. If the Command entry is blank the command will just be the word

being looked up. If these lines are filled in correctly the clue editor button will bring up the dictionary entry

for the word that is being clued; if not, it will merely activate the dictionary program and you will have to

type in the word yourself. For example, for the old RH Webster dictionary:

Service Topic Command

RH Webster's DIC Unabridged: RHUD
College: RHCD

Thesaurus: RHCT

LOOKUP %s

(Don’t actually include the “College” or “Unabridged” bit, just the bit in capitals).
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For programs that do not support DDE you should make sure the dictionary name is the same as the title

on the window when you open the dictionary (or an unambiguous start). When the dictionary is opened

the lookup word is put on the clipboard. You may be able to send some keystrokes to the application to

paste in the word in order to look it up automatically. To do this set the Send Keystrokes entry. See the

topic on sending keystrokes.

The programs that you add buttons for don't of course have to be dictionaries. You can create an icon for

anything. Say you wanted to be able to start Notepad easily. You could add a 'dictionary' called 'Notepad',

file name 'c:\windows\notepad.exe' and leave the other entries blank.
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Hidden words

A word search puzzle may have some squares that are not used to form any of the search words. The letters

in these squares may spell out a hidden word of phrase. Select Hidden word (unused letters) on the Words
menu to view or set a hidden word. In other puzzle styles you can use key words to do something similar.

To generate a word search puzzle using a given hidden word click the Hidden word/phrase button in the

Create word search puzzle window.



150

Words blacklist

When making puzzles you may wish to try to avoid vulgar or offensive words. You can check a puzzle against

a blacklist using the Accidental Words feature. Click the Edit blacklist button in this window to view and edit

the list. When making a word search puzzle you can also use your blacklist to avoid your blacklisted words.

The blacklist is saved in a file called blacklist.txt in your theme word lists folder.
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Checking for accidental words

Select Check accidental words on the Words menu to see if letter combinations in the grid have accidental

formed additional words. For example, you may wish to check that no vulgar or offensive words have

accidentally appeared. There are two options:

Check for words in blacklist Checks for vulgar and offensive words listed in your blacklist. Click
the Edit blacklist button to view and edit this list.

Check word list
Checks using one of the main word lists to check for words. The Max Score setting defined the
maximum score of words that are flagged.

Click on one of the found accidental words to highlight it in the grid.

If you are checking a word search puzzle this function will also check that none of the keywords appear in two

possible locations. You can also click the Add to keywords button to add an accidental word to your list of

search keywords.
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Grid Insight

Grid Insight is a feature that automatically analyses grids as you design them and insert words, showing any

problems. It will also show forced words and letters in squares where the current grid pattern and letters

require particular words or letters to be used to complete a fill.

The Grid Insight feature can be turned on and off by clicking the round button on the far right of the lower

toolbar. The color of the button indicate whether the current grid is fillable with words: red indicates that no fill

is possible, green that at least one fill exist, and gray that the area is already filled or fillability is not easy to

determine.

Exactly which things Grid Insight checks can be customized by clicking on the Grid Insight button:

Duplicate words: any exact repeat of a word will highlight both slots
Duplicate substrings (Pro Filler only): while highlight any repeated sequence of letters above a

specified length
Words not in list highlights spelling mistakes, or more specifically words that are not in your word

list
No fitting word highlights partially-filled word slots where no word in the list will fit
No intersection highlights pairs of word slots where no intersection is possible using words in the

word list
No group intersections highlights slots that cannot be filled consistently simultaneously with

nearby and intersecting slots. The reason for this kind of failure cannot be fully localized, and it is a
failure of a multiple word slot constraint.

Forced letters shows any letters which are forced by all possible fills as grey in the grid
Full Fill Check tests whether the entire connected unfilled area is fillable, and updates the Grid

Insight button color accordingly. The time limit for this check can be specified, so large amounts of
computer resources are not wasted trying to find fills for only partially-completed grids.

Which word list Grid Insight uses can be specified by clicking the Settings icon top right of the Grid Insight
window (or Change List Usage on the Words menu). You can either use the same word list and settings for all
your puzzles, or match the settings currently being used for grid filling (set in Fill Grid).

If Grid Insight finds forced letters or words (shown as small letters in the grid), you can accept them by

pressing Ctrl+Return.
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Adding images to a puzzle

It is possible to place pictures in various positions in the crossword grid taking up one or many squares. Select

Paste image... from the Edit menu to insert an image from the clipboard, or Insert image file... to insert an

image from a file. You can insert either a bitmap or a Windows picture (metafile). You will be prompted for

some options for pasting the image. To put a background image in a single square, use the option in Square

Properties instead.

The Left Square and Top Square options determine the co-ordinate of the top-left of the image in the

crossword grid. Set the Squares Wide and Squares High to the width and height (in grid squares) you want

the image to have. It must cover an integral number of squares.

Check the Add Border box to have a line around the image.

The Arrow settings allow you to add a little arrow coming from the image, useful in conjunction with a clue

squares crossword. Grid X sets the left square that you want to have the arrow, Grid Y sets the right square.

You can choose which direction you want the arrow to point in.

You can change the image's properties once it is in the grid by right-clicking on it with the mouse. You can also

delete the image this way.

You cannot undo adding and removing images.
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Save

Select Save from the file menu or press Ctrl+S to save the puzzle with its present name. If the puzzle is

untitled the Save As dialogue box will open for you to choose a name.
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Puzzle Views

When you edit a grid as much information is shown as possible as regards square colors and settings. Use the

Puzzle and Solution buttons on the toolbar to preview what the puzzle and solution will look like. You can also

select View from the Grid menu, where you can also choose whether to show numbers when editing the grid.

Some square properties depend on whether it is the solution or puzzle that is being viewed, so it is a good idea

to use the view feature to make sure everything works correctly in both views. To change whether a picture is

shown in the solution right-click on the picture. To change whether clue squares are shown in the solution see

Grid Properties.
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Checking puzzles

Click the check toolbar icon ( ) to check a grid for unwritten clues. This is especially useful for clues in

squares puzzles where it can be tricky to ensure that all words are correctly clued.

To check a puzzle for duplicate or similar words use Words and word statistics on the Words menu. You can

also check for accidental words.

To check a grid as you make it for conformance with specific style conventions (e.g. avoiding two-letter words),

use the Style checking feature.
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Puzzle Information

Select Information... from the File menu to view information about the puzzle title, author, copyright and

description.

At the top of the window there are two additional tab pages:

Metadata On this page you can see or add additional data that describes the file, for example the
date, editor, etc. You can also add custom fields to describe additional data. The information in these
fields are included when you export an XML file.

File
This page shows the fully qualified puzzle file name and the original template. If the puzzle is saved on
disk there is also a button to press to open Windows Explorer in the file's folder.

The information can be used when printing (with Headers) to give information about the puzzle. Crossword

templates can contain default information, so that, for example, every puzzle you create automatically has your

name as the author.

See also puzzle statistics.
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Rebus puzzles

A rebus puzzle has one or more squares in the grid containing a multi-letter word that represent a particular

picture. For example a puzzle might contain the word crossroads where cross is all in one square. Optionally

the square can also represented by a picture, e.g. of a cross.

To make a rebus puzzle manually use Square Properties to set the multiple letters for a square and to set the

square's background picture. Check the Rebus option box so that the picture is shown in the solution but not

in the puzzle. When you edit the grid you will see both the multi-letter word and the background picture.

A sample puzzle is provided called Rebus demo that you can look at as an example.

The Pro Grid Filler also supports setting rebus words when filling, automatically using multiple-letters in each

square where they appear in the word list. See the Pro Filler setting tabs.
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Word List Usage

Select Change List Usage... from the Words menu to set and change the way the word lists are used by

AutoFind in the current crossword and various other word list settings. There are four pages of options, click

on the tabs at the top of the dialog box for the page you want. Check the Save as default box to save the

changes for the next time you use the program.

AutoFind

All un-selected available word lists are shown on the left, the ones selected for use with AutoFind are shown

on the right. Press the arrow buttons to move lists between the two. If you select the Use all check-box, all the

available lists will be used (up to a maximum of 25). The word lists shown on the right are the ones that are

searched when you invoke AutoFind.. The settings can either be applied to all puzzles that you make, or they

can be set per puzzle (and saved in template files). This option is set using the radio button at the bottom.

Anagrams

Select the word list you want to use for finding anagrams in the List to use combo-box. The anagram finder

will not use words with a score less than that specified in the Minimum word score entry. The Maximum
number of words in anagram option lets you put a limit on the type of multi-word anagrams that are found.

Word Finding

Use this page to set further options for word finding, based on the word lists you have selected in the Select
word lists page. The word finding features will not find words with score less than that specified under

Minimum word score. Change the Maximum number of words to find to prevent the program spending

ages finding thousands and thousands of matches for an un-restricting search. Select the last check box if you

want AutoFind to show only words that will allow you to find words that fit in the intersecting word slots. This is

useful as it ensures that a word you find using AutoFind will not immediately generate a letter combination in

the grid which no words will fit.

Grid Insight

Use this page to set whether Grid Insight uses the same setting as the current grid's fill, or whether it uses

fixed global word list settings. If you just want to check consistency of the grid with your standard fill setting you

probably want to Use Fill Grid/Autofill options of active puzzle. If you prefer Grid Insight to use a different

word list, for example a much larger word list to check whether the grid is still fillable if you include more

obscure words, select Use fixed global settings. You can specify a minimum word score for the fill, and the

minimum-length substring to check for duplication (Pro Filler, if that setting is turned on in the Grid Insight

options.

Spelling

Select the word list to use for spell-checking clues in the Review/edit clues box, and for checking the words in

the grid (listed in the puzzle statistics box). Words with scores less than the Minimum word score will be

counted as mistakes. You can choose to Ignore words shorter than a certain length, ignore words starting
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with a capital (except ones at the beginning of clues), or words that are in uppercase. The Suggestions
language is used to determine the language used when making suggestions for corrections (if your language

is not available, you may need to install additional Windows components).

You can change which word lists are used for AutoFill in the Fill Grid dialog box.
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Regular Expressions

This is an advanced topic (not available in the demo)

Regular expressions are very powerful but also hard to understand and use.

The Find Word feature allows you to do very general pattern matches using what are known as regular

expressions. They can also be used when using Duplicate/Filter list to filter or modify a word list.

Regular expression syntax is not the same as the basic Find Word syntax. To use the extended features of

regular expressions prefix your search string with a backslash (unless it is obviously a regular expression

because it contains one of the special symbols \(+{$| in which case the leading backslash is

unnecessary).

A detailed explanation of regular expressions is not possible here. There are many websites and reference

books available (the Crossword Compiler feature uses perl-like syntax). However, in summary the basic

special characters are

.
(dot) Match any one character

[..]
Character class: match any characters listed

[^…]
Negated character class: match any character not
listed

*
Match previous entity 0 or more times

+
Match previous entity 1 or more times

?
Match previous entity 0 or 1 times

^
Start of word or collocation

$
End of word or collocation

|
Or

In addition, as with the basic syntax, you can use the : and ; prefixes to make the search case or punctuation

sensitive. Examples

\AP*X
finds abaxial, addax, Ajax, coaxer, pax, etc.
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\AP.*X
finds apex, apexes, apoplexy, soapbox, etc.

\^AP.*X$
finds apex, appendix, Appomattox, apteryx

:\^A.*x
finds Aix-en-Provence, Ajax, etc

\ap.?x
finds apex, apexes

Brackets can be used to group letters, so ^(#@)*$ finds, immediately after the start, and up to the end, a

series of zero or more letter combinations of the form consonant vowel. Examples

^(#@)*$
finds baba, badinage, magic eye, Tahiti, etc

(tt|ll).*(zz|ww)
finds hail-fellow-well-met, hollow-ware

(zz|ss)$
finds abbess, ableness, zizz, etc.

You can also use \1. \2 etc. to stand for parts of a match in a previous bracket,

(l.*t).*\1
finds, helter-skelter, little by little,
multicultural, etc

(…)\1
finds ack-ack, assassin, Mississippi,
satiation, etc

^(….).*\1$
finds abracadabra, airy-fairy, beriberi,
hand in hand, etc.

;^(....)\1$
finds beriberi, caracara, chowchow,
couscous, hotshots

(..)i(..).*\2i\1
finds non-intervention,
noninterventionist, noninterventionists

^([xjq]).*\1
finds jejune, jumbo jet, quinquina, x-
axis, etc

Regular expression replacements

You can use the Duplicate/Filter list feature to make letter string replacements in a word list. The search

pattern can be any regular expression, which is replaced by the text you give as the replacement. The

replacement text can include $1, $2, etc., to stand for bracketed parts of a match.
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Replacements can be simple, like replacing ise with ize, or more powerful. For example to replace all double

letters with single letters use (.)\1 as the replacement pattern, and $1 as the replacement text. Or use the

replacement a(.)a with b$1$1b to change, for example, again into bggbin.
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Viewing words used by Fill Grid

When you have completed a fill using AutoFill or Fill Grid you can view the words used in the grid by clicking

the Words used button on the filling toolbar. If you want to view words at any other time select Words and
word statistics from the Words menu.

The window lists the words used in fill order, along with the words’ scores. Theme or Rebus words are shown

in different colors. Press OK to close the window or press one of the other buttons at the bottom. Click on

Refill from selected word to undo all the words in the grid until it the selected word and then refill with a

different word in that word slot. Click Refill without selected word to do the same as Refill from selected
word but to remove the words from the word list so that they can’t be used again elsewhere.

Click the Check for similar words button to analyse the words used and highlight substrings they have in

common. For instance if the grid contained REOCCUR and OCCUR the program would list the two words with

the common substring highlighted. This can be useful if you want to avoid using similar words.

You can edit scores of the words directly by clicking on the score. Use the right-click menu on a selected word

to delete it from one or more other word lists, or change the score in multiple word lists.

Select Always show words from the Words Used button drop-down menu to automatically show the list of

used words whenever a fill completes. The font used for displaying the words can be changed under

Preferences.
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Add puzzle clues to database

Add the clues from the current puzzle to a Clue Database by selecting Add puzzle clues to database from

the Clue menu.

This will add all the clues in the current crossword to a database, though any formatting information in a clue

will be lost (e.g. bold, italic). If you only want to add some specific clues to the database, click the Specific
clues button, and check the clues that you want to add.

Check the Date stamp clue with data box to mark each clue with the given date (by default, today’s date,

though you can change it).

Check the Set field valuebox, and enter some text, to see set additional data for each clue. This can be useful

for tracking the origin of clues, or where they have been used. The Citation field is present by default, but you

can also add other data values as custom columns using the Clue Database Manager.

You can change how it handles entries in the database that already have the same word and clue, by selecting

one of the three choices below. When each item is selected, the options panel on the right gives additional

choices.

Update older date will replace the date field of existing older clues (or clues with no date) with the
new date, and not add a new entry. Whether or not clues are regarded as the same if only the citation
differs is determined by whether the Duplicate checking ignores differences in citation box is
checked. When this is unchecked, no clues will the updated or replaced that have a different citation to
the citation in the puzzle.

Replace will update all existing matching clues, regardless of date and citation, with the new date
and citation. Alternatively you can check the only replace clues with box, and only replace clues that
currently have a specific citation in the database (or other custom field matching a given value; if the
match is blank, it will replace entries that are currently with no citation). Without this option, multiple
clues with different citations may all be changed potentially giving duplicate entries.

Add new copy Will make a new clue entry with the current date and citation, also keeping existing
clues with other information
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Crossword statistics, words and letters

Select statistics from the File menu to show statistical information about the current crossword. You can also

select Words and word statistics from the Words menu to show the Words page of statistics directly. The

statistics window can be left open while you edit the puzzle, and will automatically update to reflect changes.

There are five pages of information:

General

This shows various self-explanatory statistics about the various types of squares used, clues written, etc.

The Clue Character count shows the number of letters used both with and without including the clue numbers,

formats and headings.

The program calculates whether the grid is pangrammatic (containing all letters of the alphabet) using the

alphabet selected under Clue Properties . It is not classed as pangrammatic if any of the letters are missing or

the grid contains letters not in the alphabet. See the Letters tab see individual letter counts.

Words

The left list box shows an alphabetical list of all the words in the puzzle. Click on any word to select it in the

grid. The right-hand panel shows a graph of the word length or clue tag frequencies. Click on any line in the

graph to select the corresponding words in the grid. Clue tags can be changed in the Clue Editor.

Click the Select words not in spelling list button to highlight words which aren't in the word list you've set up

for spell-checking. The word list is set in the List Usage box. If some words are incomplete (i.e. show up with

"?" in place of some letters) the program will highlight the words which have no matches in the spelling list.

Similar words

The list box shows any words in the grid which contain common groups of letters. The common group of letters

is colored in red, and words with the most common sequential letters are listed first. This is useful for checking

that you are not using words which a too similar, even though they're not exactly identical. Click on any line to

select in the grid the words listed on that line.

The Professional Grid Filler has an option Avoid repeating substrings in different words that can be set to

avoid using similar words when you fill a grid.

Accidental words

See the Accidental Words topic for details.

Letters

This page shows the number of times each letter is used in the grid, and any letters in the alphabet (set under

Clue Properties) that are unused. You can click on any of the letter counts to select them in the grid.
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Page Setup

Select Page Setup... from the File menu to change the margins used when the puzzle is printed.

All measurements are in centimeters.
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Lookup Lists

When you press the book button on the Clue Editor toolbar a menu pops up with a list of available look-ups

which are available. You can also press Ctrl+L. By default, there are Letter Indicators and Anagram Indicators

and a couple of others. When you select an option another menu pops up with the available words. Selecting

the word on the menu pastes it into the clue editor.

You can edit the letter and anagram indicators displayed by editing the ANAGINDS and LETIND files supplied

with Crossword Compiler. Edit them using Notepad. The format of the file is

MENU <Menu caption>

First on submenu

Second on submenu

MENU <Second menu caption>

First on second submenu

etc...

The menu captions can contain the '&' character which is the keyboard shortcut.

You can add another lookup list by selecting the Custom Lookups page from the Preferences dialog box.
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Adding clues from files

Select Add clues from files from the Menu button in the Clue Database Manager to add all the clues in a set

of files to a clue database.

Select the files whose clues you want to add (hold down Ctrl and click on each file) and press Open. You will

then be asked whether you want to timestamp the clues with the date of the files from which they come. If you

click Yes the clues will be added to the database in date order, and you will be able to view the date in the

Clue Editor when the clue is displayed.
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Merging clue databases

You can merge clue databases together by using the Merge Databases... command on Menu drop-down in

the database manager. Just select a database whose clues you wish to add to currently selected one.

If you want to add clues from an external database, for example a CSV (Comma Separated Values) file from a

spreadsheet program, first use Open/Convert on the Menu button to convert it, then merge it.
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Export groups

If you wish to export various files at once, you can define an export group. For example this will let you export

separate pictures of the puzzle and solution all in one go, or a set of files for sending to a publisher.

To define an export group you first need to save the export settings that you want to group together. Do this in

the Export window. Then select the Export groups tab at the top of the Export window and select the export

formats that you want to export together. You can either export the selected formats directly, or save your

group for future re-use. To save the group type a name in the New box and press the Add button.

Your saved export groups are shown in the left panel of the Export groups page. Select a group to view or edit

the included export settings. You can select a group or setting and press the Delete key if you wish to delete it.

Deleting an export format will also delete it from any groups in which it is included.

There is also an option to zip the exported files into a single zip file; to do this select the Zip exported files
box.

When you save the group you will be prompted for a file name. The extension will be changed appropriately for

the different format files you are exporting. However, if you are exporting multiple files in the same format, for

example a picture of the grid and solution, the filename for each export needs to be made distinct. To do this

the program uses the text after the hyphen in the export format name. For example if you have an export

format called "Picture - solution", the file exported as part of the export group might be called

"MyPicture_solution".

If you have saved an export group, you can export it quickly by selecting it from the Export format option on

the File menu. Advanced users can also export it using a DDE script.
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Exporting pictures

Metafiles (WMF, EMF) - Bitmaps (BMP, GIF, TIF, JPG, PNG) - EPS (encalsulated PostScript) - PDF -
Comparison

You can export in a variety of picture formats by selecting Export from the File menu and choosing one of the

options in the left panel.

Pictures are exported at the size specified in the Grid Properties dialog box. There are three main types of

picture you can export --- select one of the tabs in the export window.

Metafiles

These are Windows specific resizable pictures, and are good for exporting grids to other Windows programs

like desktop publishers.

However if metafiles are shown on a low resolution device like a screen the grid lines may appear uneven or

not show up at all (though they should print correctly). Select the For screen option to use thin grid lines which

will appear correctly on screen. This is not such a good option if the metafile will ultimately be printed, but if the

metafile will only be viewed on screen then this is the option to use. A metafile with the For screen option

generally has a smaller file size than the corresponding bitmap and has the advantage of being resizable.

However, bitmaps are more portable and reliable, and should usually be used instead for viewing on screen.

Bitmaps

You can export bitmaps at various resolutions and color depths, and in various different file formats. With

bitmaps the lines will always look correct if the bitmap is shown at its natural size, or if you export at sufficiently

high resolution.

The default Resolution setting is that of your screen, and will produce an image that looks much like the

puzzle as you edit it in Crossword Compiler (square sizes in physical units are set in Grid Properties). Select a

higher resolution setting if you want to export a bitmap for eventual printing. Either select a resolution from the

drop-down list or type in a value of your own. Note that exporting at high resolution can use a lot of system

memory and lead to a large exported file. You can instead specify a Target pixel width, which may be useful if

you want an image with particular dimension in pixels, rather than a specific physical size at a given resolution.

Change the Colors setting to control the color depth of the exported image. The 16 million colors setting will

always produce high quality results, and should be used if your grid contains any color pictures. However, if

your puzzle is essentially black and white or only has a few colors you can reduce the color depth to produce a

significantly smaller image file.

If you select the Anti-aliasing option the bitmap produced will use intermediate colors around the edges of

letters to give the impression of a higher resolution image. If may also result in a significantly better quality

export if your grid contains pictures. You cannot use anti-aliasing with the monochrome color setting.

If you export in various different picture formats
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Bitmap pictures are supported by most Windows programs and many others. The main
disadvantage is that the bitmap file may be very large.

GIF pictures is an old format for images on a web page. It is a lossless compressed format
supporting a maximum of 256 colors, and no longer usually recommended.

PNG pictures are useful if you want to use the image on a web page. It is a flexible lossless
compressed format supporting any number of colors.

JPG pictures are useful if you want to use the image on a web page. It is a full-color compressed
format that does not preserve full image quality.

TIFF pictures are similar to bitmaps, but they are compressed and are highly portable. This is
probably the best option is you are exporting high-resolution images for publishing. At high resolutions
TIFF file sizes can be up to 50 times smaller than the corresponding bitmap files. TIFFs are exported in
full color.

EPS (Encapsulated Postscript)

EPS is preferred by some publishers and is probably the best format for exporting for use on a Macintosh

computer, especially with QuarkXpress. EPS file can be resized in other programs without loss of quality.

Crossword Compiler can generate EPS files in two modes:

Basic with postscript fonts This generates small and simple EPS files using the postscript font.
This format is not available for word search puzzles, or if the grid contains images or uses a non-West
European font. Crossword Compiler automatically selects a PostScript font similar to the one you have
selected as the grid font. You can however select from a range of fonts in the Font combo box, or type
in the name of a different font (advanced users only).

General (font embedding)
This generates larger files, using exactly your chosen font style. This mode supports all puzzle styles,
including those containing images.

If the Include TIFF preview box is checked the file will include an embedded color bitmap which you can then

view on screen as a placeholder for the PostScript that will be used when the file is ultimately printed. The

disadvantage of including a preview is that it will make the file size a little larger, and may make the puzzle look

less high-quality than the final result when the postscript is used.

PDF

PDF is similar to EPS (general format with font embedding), but is more widely viewable using free software

such as Acrobat Reader. It is less commonly used by professional publishers, though its use is becoming

increasingly common. The function in the Export Puzzle window only exports the grid; to export a page

containing puzzle and clues see Print/Export Worksheet feature instead.

Comparison

Here is a table comparing the different picture formats, the color depths available, the typical files sizes, and

their suitability for different purposes. The file size examples are for a black and white grid with antialiasing.

File sizes for the compressed formats (GIF and TIFF) will increase significantly if there are more colors or the

grid contains pictures.

Format Colors Typical file
size (KB)

Screen Mac
Publishing

Windows
Publishing
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Metafile  5 Option Maybe Yes

Bitmap 2
16
256
16 million

20
75
150
450

Yes OK Yes

GIF <=256 6 Yes
(Web)

No No

TIFF 75 DPI
TIFF 300 DPI

>=16 7
53

Yes
(not Web)

Yes Yes

EPS
With Preview

 4
12

No Yes Yes

PDF  400 Yes (web) Maybe Maybe

To see the effect of anti-aliasing compare these:

With Anti-aliasing Without anti-aliasing

     
     

The ones with anti-aliasing look as though they have thicker lines and letters. That is because it looks more

exactly in proportion to the settings set under grid properties than the other image. With no anti-aliasing the

lines are restricted to being an exact number of pixels wide. You can also see that anti-aliasing has made the

small numbers clearer, especially the 4. However, there is little point in using anti-aliasing if you are exporting

at the highest resolution your printer can support. It is mostly useful for low-resolution images that will be

viewed on screen.
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XML file format

You can save a file in XML format using Save As on the File menu and selecting XML puzzle under Save as
type.

XML is a standardized extensible format for exchanging data; other programs may be able to read and

manipulate XML files. You can open an XML puzzle file with Crossword Compiler as you would a normal file.

Note however that the XML format does not include all the possible constructor settings of the default file

format; it does however cover essentially all properties required by solving programs

The interactive puzzle applet supplied with Crossword Compiler uses an XML file format. Puzzles created for

use with the solving applet can also be opened with Crossword Compiler.

Puzzles saved as XML using Save As do not include additional layout options required by the solving applet.

However, the file does include full solution information, which will not be the case if you export a web

crossword without solution information.

The basic XML format is documented in an .xsd file at https://crossword.info/xml/rectangular-puzzle.xsd.

Applet files generated by Crossword Compiler contain additional information relating to applet formatting etc.

https://crossword.info/xml/rectangular-puzzle.xsd
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Uploading web pages

When you have exported a web page or an interactive applet puzzle you will need to upload the files to your

website.

After exporting a file you will be shown a list of the files that need to be uploaded. You can if you like drag and

drop these files to your web folder or FTP (uploading) software. Otherwise, use your uploading software to

upload the files from the export folder.

If you export an interactive puzzle you also need to upload the applet files. You only need to do this once since

all your puzzles can use the same applet files on your website. These are automatically copied to the folder

where you export the web page.

WordPress sites can use the WordPress Plugin to easily upload the puzzles.

https://www.crossword-compiler.com/wordpress.html
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The program exports complete web pages you can use. This topic describes options for more advanced usage if you
want to customize the behaviour of the applet on your website. The first topic shows how to modify the parameters
passed to the applet in the HTML page, the second topic describes how to customize display using CSS and use
JavaScript functions programmatically.
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Solving applet parameters

The XML data is exported from Crossword Compiler as a .js file containing a JavaScript string called
"CrosswordPuzzleData". The applet is called from JavaScript in your web page, with an #id containing the id of a DIV
element that will actually contain the applet content (see Crossword Compiler's default output for an example). The
main call is of the form

$(“#id”) .CrosswordCompiler(1,2,3);
1. This parameter must contain a string which is the xml data, it is REQUIRED. Default is

“CrosswordPuzzleData”.
2. This parameter contains an JSON array to override the default images for graphical buttons (the default

images come with the applet files). If there is no need to override the images, this must be set to null. Note
that if you speciifc myImage.png, you must also provide in the same location myImage_2x.png for high-
resolution screens (e.g. iPad). Example :

{“reveal-word”: ”path to image”, “reveal-letter”: ”path to image”,

“revert”: ”path to image”, “solution”: “path to image”,

“check” : “path to image”, “pencil”: “path to image”,

“submit” : “path to image”, “save” : “path to image” }

3.
PARAMETER VALUE DESCRIPTION

BACKCOLOR Any Html valid Color Background Color for the puzzle
SELCOLOR Any Html valid Color Color for the selected cells.
URLCOLOR Any Html valid Color Color for url clues color

CLUEURLTARGET STRING  
HINTURLTEXT String The text to be in the url, default is

“?”
CLUECOLOR Any Html valid Color Color for Clues
FINISDHEURL String  

FINISHEDURLFRAME String  
COMPLETITIONPICTURE String  

COMPLETITIONPICTUREURL String  
COMPLETITIONPICTUREURLFRAME   

MAXCHEATS Any number > 0 The max number for cheating
SCROLLWIDTH Any number > 0  

SCROLLHEIGHT Any number > 0  
SUBMIT String Url for submit

SUBMITMETHOD String  
SUBMITFRAME string  

SAVE String Url for Save
GRIDBACKCOLOR Any Html valid Color Grid’s Background Color

WRONGCOLOR Any Html valid Color Color for wrong letters.
GRIDCOLOR Any Html valid Color Grid’s Color

BLOCKCOLOR Any Html valid Color Color for block in grid
FONTCOLOR Any Html valid Color Color for font in cells
NUMCOLOR Any Html valid Color Color for numbers in cell
CURCOLOR Any Html valid Color Color for the cell with focus

REVEALEDCOLOR Any Html valid Color Color for Revealed letters
COMPLETECORRECT true   or   false Only if correct

FRIENDLYSUBMIT true  or  false Friendly Submit
SHOWSOL True  or false To show solution on Load

TITLE String  
COPYRIGHT String  
PROGRESS String To load Progress.

TIMEFROMLOAD true or false To start timer on load.
STARTIME Any number > 0 Initial Timer value.

TIMER true or false To enabled timer
NOPAUSE true or false To let user pause the timer

TITLEHEIGHT Any number>0 Title Height
TITLELEFT true or false To align title to the left

URL Format

Each URL given for a puzzle can contain placeholders to be replaced with data from the puzzle. The following list

describes them:
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%SUBMIT% Is replaced by progress considering “Friendly
Submit” value

%MARKED% Is replaced by progress plus mark for the answers

%PROGRESS% Is replaced by progress of the puzzle

%TIME% Is replaced by time in seconds

%CHARSET% Is replaced by the Charset

%KEYWORD% Is replaced by the keyword progress.
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Customizing using JavaScript and CSS

In addition to changing options using the applet settings and parameters above, you can also access some functions
of the puzzle applet at runtime using JavaScript, and customize certain aspects of the default display using CSS.
Javascript functions are available from the CrossWord object of the DIV element containing the puzzle, e.g.

getElementById('CrosswordCompilerPuz').CrossWord 

Programmtically calling button actions You can call the button actions by using the ButtonActions
element of the Grid element. For example this JavaScript will do the same as the user clicking on the reveal-
letter button.

getElementById('CrosswordCompilerPuz').CrossWord.Grid.Button

Actions['reveal-letter'](); 

Using PuzzleState
The global PuzzleState element can be used to access and change the current puzzle state.

getElementById('CrosswordCompilerPuz').CrossWord.PuzzleState.GetProgressString(friendly,
encoded) returns the current grid progress (filled in letters). E.g. PuzzleState.GetProgressString(true,
true); Shows the Friendly submit format (see above) and URL encodes the entries.

getElementById('CrosswordCompilerPuz').CrossWord.PuzzleState.GetTime() returns the
current solution time

getElementById('CrosswordCompilerPuz').CrossWord.PuzzleState.PuzzleCompleted is a
function (no parameters) that you can override to replace the default function when a puzzle is
completed.

Customizing colors with style sheets (CSS)
Various elements of the puzzle can be targeted via CSS by specifiying various element classes.

.Clues is the block of clues, .ClueHeading is the Across/Down label, .ClueText is the text of a clue
and .ClueNumber is the number. For example to set the clue text blue

.Clues .ClueText{ 

 color:blue; 

} 

The state also changes a containing class, so you can use .Completed and .Selected. E.g. To set the
completed clue text color to be yellow with strikethrough:

.Clues .Completed .ClueText{ 

 text-decoration: line-through; 

 color:yellow; 

} 

Currently similar customization is not easily possible for the grid. 
Using custom graphical button images with CSS

In addition to overriding the image names as specified above, you can also do it via CSS by targeting the
buttons using .CCPuzButtons .action-name. For example this would replace the reveal-word icon
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.CCPuzButtons .reveal-word{ 

 background:url(myImage.png) no-repeat; 

} 

Note that for high-res screens you also need to provide a myImage_2x.png file, and specify in CSS the high-
res icon versions. e.g.

@media (-webkit-min-device-pixel-ratio: 2),(min-

resolution:2dppx),(min-resolution: 192dpi) { 

.CCPuzButtons .reveal-word{ 

 background:url(myImage_2x.png) no-repeat; 

}} 
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Change formats/case in word lists

Select the Change formats/case option from the Word List Manager’s Word List menu to change the

punctuation and capitalization of words in the selected word list.

The Change case setting determines how to map the words’ case. The Punctuation setting determines how

the punctuation is changed. Select the Set punctuation/formats from option, and a word list name, to apply

the punctuation of the words given in that word list to the current list. This can be useful if you have a new list

that is un-punctuated and want to punctuate it correctly using the information in another correctly-punctuated

word list.

Select the Remove duplicates option to remove words that differ only by case or punctuation. You can

choose to prefer upper case or lower case; if words of the same score exist with different capitalization this

setting will be used to determine which to keep (words of higher score are kept by preference).

The Map to equivalent options maps letters as defined in the word list’s letter mapping.
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Copying and filtering Word Lists

To make a copy of a word list select a word list and click on Duplicate/filter list on the Word List Manager’s

Word List menu. Then type in a name for the copy of the word list.

If you want the copy to contain only words of a particular score, click the Include only words with scores of:
check box and select the scores you want to include (use Ctrl and Shift plus mouse clicks to select a range of

set of values). To restrict to particular word length, use the options on the Word lengths tab. You can also use

the Format tab to only include words matching a selection of case/punctuation filters.

If you want the copy to contain only words matching a particular pattern enter the pattern text as you would

using Find Word.

If you want to alter the word list you can use the Replace option to replace character strings with a

replacement. The replacements can use regular expressions.

You can also filter the word list to contain only words that are also present in another list. Select the Equivalent

Words box if you don’t care about the punctuation or capitalization of the words, and the Words NOT in box if

instead you want the filtered list to contain only words not in the select word list.

Operations are performed in the order given above, in other words replacements occur on the list after

matching to any specified pattern but before comparing with another word list.

The Duplicate/filter list window is also a handy way of viewing the number of words with each word score.
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Changing the scores of words in a puzzle

If you regularly create puzzles using the same word list you might like to avoid words that you have used

before. You can do this by changing the scores of the words in the word list each time you have made a

puzzle. Alternatively you might want to add words in a puzzle to a word list.

To do these things select Change scores of words in puzzle from the Words menu and select the word lists

that you want to change. You can either change the scores by a certain amount, or set the scores to a specific

value.

By setting a fixed low score for the words' scores you can cut them out of future grid fills completely by setting

the minimum cut-off score to above the score which you have given the words.

By just decreasing the scores by some amount you can ensure that AutoFill and Fill Grid give a low priority to

words that you have used most often before.

Click the Add words not in list box to add words to the list as well as changing the scores of words that are

already in the list. If you just want to add words without changing the scores of words already in the list you

can set the Change scores by setting to zero.

If you only want to change some or specific word scores, use View/Edit words and scores on the Words menu.
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View/Edit words and scores

Select View/Edit words and scores< from the Words menu to show a list of all the words in the puzzle along

with their score. The panel on the right shows all your word lists. Clicking on a word on the left will show the

score of that word in all of your lists (or no score if the word is not in a particular word list). To edit the score,

click on the score on the left and enter the new number. This will either change just the specific word list

selected, or all word lists, or all word lists which have the word at the same score, depending on which option

you select from the drop-down box on the top right.

You can view the scores of all the words in other lists by clicking on different list names on the right.

By default, words are exactly matched to words in word lists, so, for example, 'Nice' and 'nice' are regarded as

different words. Click the Match equivalent words box if you want to match irrespective of case and

formatting.

To adjust scores of multiple words, or add/remove them from word lists, select the wors on the left (e.g. by Ctrl-

clicking) and then use right click (or the Change Scores button) to select what you want to do with them.

If the solution words in the puzzle are not correctly formatted (wrong case or punctuation), you can set the

solution words to match the words in a selected word list by selecting Set all solution formats from list from

the Change Scores button drop-down menu.
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Sending Keystrokes

You can send keystrokes to a dictionary when it is opened to look up the word that is on the clipboard. The

keystrokes setting can contain normal letters as they are. You can use the following prefix characters:

+    Shift

@   Alt

^   Control

So, for example, ^v would send the keystroke Ctrl+v. You can also send extended keys, using the following

codes in curly brackets { }:

 INS

 DEL

 ENTER

 TAB

 ESC

 BACK

 UP

 DOWN

 LEFT

 RIGHT

 PGDN

 PGUP

 END

 HOME

 F1

 F2

 F3

 F4

 F5

 F6

 F7

 F8

 F9

 F10

 F11

 F12

So, for example, ^{INS} would send Ctrl+Insert. There are also some special non-keystroke options:

CLEAREDIT
Attempts to focus any edit control and clears the text in it

Keys only sent if the program is not already open
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IFSTART

IFOPEN
Keys only sent if the program is already open
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Save As

You can give a puzzle a name, or save under a new name by selecting Save As... from the File menu. Enter

the name for the puzzle and press OK. You can select a different folder or save to a different disk as you like.

You can save a puzzle with its current name by pressing Ctrl+S or selecting Save from the File menu.

To save in old Crossword Compiler 4/5 format select the option from the Save as Type drop-down box.

Otherwise, the file will require Crossword Compiler 6 or higher to be opened. Of course if you use features

introduced in a particular version they will not be available if opened in an older version.

To save a puzzle for use with other programs use the Export feature.
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Style Checking

Select one of the Style checking options on the Grid menu to color squares in the grid that are not allowed

according to various popular grid pattern standards.

In the American style, every letter must have two words going through it, and no two letters words are

allowed. Any squares inconsistent with this will be shown colored so that you know where to correct the grid

design. It will also check for disconnected areas of the grid.

In the Cryptic/Quick style, every alternate letter in each word must intersect another word. This standard is

usually adhered to by UK broadsheets and elsewhere, though other publications may allow more non-

intersecting letters. Two-letter words and disconnected regions are also not allowed.

Select the 2 letter words option if you just want to prohibit two-letter words, without either of the above more

stringent requirements.

Use the Custom option if you want to find-tune exactly which rules are applied.

The style checking option can be saved using a template for making puzzles in future.
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Advanced Auto-publishing Features

For the advanced Desktop publisher Crossword Compiler supports DDE (Dynamic Data Exchange). This

allows you to write macros or programs to quickly create publications based on Crossword Compiler files. For

instance your macro or program could go through a list of files, for each one copying the puzzle and clues to

the clipboard, arranging them in the publishing program, creating a new page, and then opening the next

crossword and repeating.

The DDE topic to use is control; the application name is ccw. Crossword Compiler can accept macro strings

in the following format:

[Command1(Params1)][Command2(Params2)][.....

The commands and parameters available are:

Command Parameters Example

Open "Filename" (must be in quotes) [Open("C:\CCW\My Crossword")]

Open "Filename", "Template" [Open("C:\CCW\My
Crossword","Italian")]

Close None [Close()]

Quit None [Quit()]

Print None [Print()]

Export None
Number 0-12
"Export setting", "Filename"

[Export()]
[Export(2)]
[Export("PDF - solution","c:\ccw\my
puzzle.pdf")]

ExportGroup "Export group", "Filename" [ExportGroup("My Exports","c:\ccw\my
puzzle.zip")]

Open opens the specified file. Optional argument specifies template.

Close closes the active crossword

Quit closes Crossword Compiler

Print shows the Print dialog box for the active crossword.

Export with no parameters shows the Export dialog box.

Export with two parameters exports in specified custom export format to the specified filename

Export with a parameter copies the active crossword to the clipboard, according to the following parameter

mappings:

0 - Puzzle

1 - Solution

2 - Numbered solution

3 - Code Grid (in coded puzzles)

4 - Code Solution (in coded puzzles)
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5 - Code Solution text (in coded puzzles)

6 - Clues

7 - Answers

8 - Explanations

9 - Fill-in words

10 - Word list

11 - Key word grid (if grid has key word)

12 - Key word solution (if grid has key word)

Puzzle, solution and numbered solution, code grid and code solution are copied as a picture (metafile), the rest

are copied as Rich Text Format. 

ExportGroup saves a specified export format group with the given base file name (extension does not matter

unless the group is set to be zipped, in which case the extension should be .zip).

See the Export topic for how to save export formats and export groups.
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